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Résumé  

L’objectif de ce travail est la recherche d’innovations dans le domaine des 

chauffe-eaux solaires par la réalisation d’un capteur solaire thermique à stockage 

intégré. Le sable fin est utilisé comme matériau de stockage thermique. Ce moyen de 

stockage court terme permettra l’amortissement des sollicitations thermiques et 

donc l’amélioration des performances du capteur qui se traduit par une température 

de sortie plus uniforme notamment durant des passages nuageux. Ce travail de thèse 

consiste dans un premier temps à présenter le dispositif et le protocole expérimental 

puis l’élaboration d’un modèle de simulations numériques pour l’étude théorique des 

phénomènes thermiques au niveau du capteur. Un modèle numérique 3D, sous 

logiciel Ansys CFX, est utilisé et validé expérimentalement. Les résultats 

expérimentaux ont montré l’intérêt de l’utilisation du sable fin pour l’amortissement 

des sollicitations thermiques et l’amélioration de la température de sortie de l’ordre 

de 40%. En outre, une étude paramétrique est menée pour monter les effets de la 

variation de l’épaisseur du volume de stockage et le positionnement de l’échangeur 

thermique. Les résultats numériques ont montré l’importance du sable intégré où la 

température de sortie augmente de 54% pour evs=1.4cm comparé à la non utilisation 

du sable. Ainsi, un amortissement de température de l’ordre de 95% est obtenu pour 

une épaisseur du volume de stockage de 2.5cm. 

Mots clés : Amortissement thermique, capteur solaire auto_stockeur, chauffe-eau 

solaire, sable fin, stockage thermique 

 

 

 

 

 

 

 



 ملخص

 تحقيق طريق عن سيما ولا ، الشمسية المياه سخانات مجال في التجديدات عن البحث هو العمل هذا من الهدف 

 وسيط يسمح. حراري تخزين كمادة الناعم الرمل استخدام تم و الشمسي الماء سخان لمجمع متكامل تخزين

 حرارة درجة إلى يؤدي مما المجمع أداء تحسين وبالتالي الحرارية الاجهادات بتخميد هذا المدى قصير التخزين

 للأداء تجريبية دراسة من الأطروحة هذه عمل منهج يتكون. الغيوم فترات خلال خاصة انتظاما أكثر مخرج

 التحقق لغرض العددية النتائج مع عليها الحصول تم التي التجريبية النتائج مقارنة تمت الشمسي، لمجمع الحراري

 Ansys برنامج مباستخدا الأبعاد ثلاثي نموذج تطوير تم ثم. النتائج بين جيد اتفاق وجد لقد ،CFD صحة نموذج من

CFX الناعم الرمل استخدام أن التجريبية النتائج أظهرت. المجمع في الحرارة لانتقال او لظواهر النظرية للدراسة 

 دراسة إجراء تم ذلك، إلى بالإضافة. تقريبا 40% بنسبة المخرج حرارة درجة ويحسن الحرارية الاجهادات يخمد

 العددية النتائج وأظهرت. الحراري المبادل مواقع وتحديد التخزين حجم سمك تغيير تأثيرات لإظهار ةبارا متري

 يتم ، وبالتالي. الرمال استخدام بعدم مقارنة 54% بنسبة المخرج حرارة درجة ترتفع حيث المتكامل الرمل أهمية

 2.5سم .التخزين حجم لسمك 95% بنسبة الحرارة درجة تخميد على الحصول

 الطاقة تخزين ، حراري تخميد ، ناعم رمل ، الماء سخان ، متكاملة تخزين شمسية لوحة: المفتاحية الكلمات

 .الحرارية

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Summary 

The objective of this work is the search for innovations in the field of solar water 

heaters, in particular by realization of an integrated collector storage solar water 

heater. Fine sand is used as a thermal storage material. This short-term storage 

medium allow for the damping of thermal stresses and therefore the improvement of 

the collector performance which results in a more uniform outlet temperature, 

especially during cloudy periods. The approach of this thesis work consists firstly, to 

present the prototype and experimental protocol are presented and then in 

developing of a numerical simulation model for the theoretical study of collector 

thermal phenomena. An Ansys CFX 3D model is used and validated experimentally. 

The experimental results have shown the advantage of the fine sand use in terms of 

thermal stresses damping and the outlet temperature improving around 40%. In 

addition, a parametric study is conducted to show the effects of the storage volume 

thickness changing and the heat exchanger positioning. Numerical results showed the 

integrated sand importance where the outlet temperature increases by 54% 

compared to not using sand. Thus, a 95% temperature damping is obtained for a 

2.5cm storage volume thickness. 

Keywords: Integrated storage solar panel, water heater, fine sand, thermal damping, 

thermal energy storage. 
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NOMENCLATURE 

SYMBOLES 
A :  Surface de l’élément…………………………………………………............... m² 
Cp   :  Chaleur massique…………………………………………………………………… J/kg.K 
Dext  :  Diamètre extérieur du tube……………………………………………………. m 
Dint  :  Diamètre intérieur du tube…………………………………………….......... m 
e   :  Epaisseur de l’élément…………………………………………………………… m 
F :  Facteur de forme……………………………………………………………………. - 
Gr    :  Nombre de Grashof……………………………………………………………….. - 
hd,i-sab2      :  Coefficient d’échange conductif entre l’isolation et le sable 

2……………………………………………………………………………………………….. W/m².K 
hd,p-t          :  Coefficient d’échange conductif entre la plaque absorbante et 

le  tube……………………………………………………................................... W/m².K 
hd,sab2_t      :  Coefficient d’échange conductif entre le sable 2 

 et le tube…………………………………………………………………………………. W/m².K 
hc,f_t           :  Coefficient d’échange thermique par convection forcée entre 

le fluide et le tube……………………………………………………………………… W/m².K 
hc,i_a  :  Coefficient d’échange thermique par convection entre le fond 

(isolation) et l’environnement extérieur……………………………………. W/m².K 
hc,p_v2         :  Coefficient d’échange convectif entre la plaque absorbante et 

la vitre 2……………………………………………………………………………………. W/m².K 
hc,v1_a         :  Coefficient de convection naturelle entre la vitre 1 et 

l’environnement extérieur………………………………………………………… W/m².K 
hc,v2_v1       :  Coefficient d’échange convectif entre la vitre 2 et la vitre 

1………………………………………………………………………………………………… W/m².K 
hr,p_v2         :  Coefficient d’échange radiatif entre la plaque absorbante 

 et la vitre 2………………………………………………………………………………. W/m².K 
hr,v1_a         :  Coefficient d’échange radiatif entre la vitre 1 et 

 l’environnement extérieur……………………………………………………… W/m².K 
hr,v1_c         :  Coefficient d’échange radiatif entre la vitre 1 et le ciel…………… W/m².K 
hr,v2_v1        :  Coefficient d’échange radiatif entre la vitre2 et la vitre 1……….. W/m².K 
Lt    :  Longueur du tube…………………………………………………………………… m 
m  :  Masse de l’élément………………………………………………………………… kg 
𝑚̇𝑓 :  Débit massique du fluide………………………………………………………… kg/s 

Nu :  Nombre sans dimension de Nusselt………………………………………… - 
Pr :  Nombre sans dimension de Prandtl……………………………………….. - 
Re :  Nombre sans dimension de Reynolds…………………………………….. - 
T      :  Température………………………………………………………………………….. K 
U :  Coefficient de perte thermique………………………………………......... W/m².K 
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Vv  :  Vitesse du vent………………………………………………………………………. m/s 
α :  Coefficient d’absorption de l’élément…………………………………….. - 

 :  Angle d’inclinaison du capteur……………………………………………….. degrés 
ε :  Emissivité de l’élément…………………………………………………………… - 
λ  :  Conductivité thermique de l’élément………………………………........ W/m.K 

s              :  Coefficient de réflexion de la lumière diffuse du sol……………….. - 

σ0 :  Constante de Stéphane – Boltzmann……………………………............ W/m2. K4 

τ  :  Coefficient de transmission…………………………………………………….. - 
INDICES 
Abs, p : plaque absorbante  
 e : entrée  
i1 : isolant – polystyrène  
i2  : isolant – laine de verre  
s : sortie  
s ab1  : première couche du sable, e = 0.05m  
sab2 : deuxième couche du sable, e = 0.10m  
t  : totale, tube  
v1  : vitre 1  
v2 : vitre 2  
ABREVIATIONS 
AMS  : Avec Matériau de Stockage  
CSTSI : Capteurs Solaires Thermiques à Stockage Intégré   
CSTPSSI : Capteur Solaire Thermique Plan avec un Système de Stockage 

Intégré 
 

ÉcTh : Échangeur Thermique  
SMS : Sans Matériau de Stockage  
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L’énergie solaire a un énorme potentiel pour répondre à la demande mondiale 

d’énergie qui est actuellement satisfaite majoritairement par l’utilisation de 

combustibles fossiles [1,2]. L'utilisation de l’énergie solaire peut réduire l'intensité du 

réchauffement climatique et du changement climatique créés par la consommation 

excessive de combustibles fossiles. Ces dernières années, divers systèmes et  

technologies nouvelles et innovantes ont été développés exploitant l'énergie solaire 

directement ou indirectement tout en protégeant l'environnement [3]. Cependant, 

certaines de ces technologies ont parfois limites par rapport aux technologies 

exploitées par les carburants conventionnels. La conversion de l'énergie solaire par 

voie thermique est très efficace, plus respectueuse à l'environnement et 

économiquement viable par rapport aux autres voies de conversion [4] [5].  

Le chauffe-eau solaire ou capteur solaire thermique  est l'une des technologies 

de conversion thermique qui convertit directement l'énergie solaire en chaleur. Son 

potentiel de réchauffement climatique est en effet négligeable. Cette technologie est 

appropriée pour fournir de l'eau chaude de manière adéquate pour les secteurs 

domestique et industriel. Ce qui contribue également à protéger l'environnement de 

manière significative [6,7]. 

La continuité de la recherche dans le domaine des capteurs solaires 

thermiques a abouti à de nouveaux systèmes  améliorés. Selon leurs conceptions et 

leurs principes de fonctionnement, les capteurs solaires thermiques  sont  répartis 

dans les catégories suivantes, capteur solaire thermique passif[8], capteur solaire 

thermique actifs ou à circulation forcée[9], capteurs solaires thermique à eau avec un 

système de stockage indirect [10,11], capteur solaire thermique avec un système de 

stockage intégré et bien d’autres et système hybride où l’appoint électrique est 

fourni comme unité de secours pour assurer le fonctionnement continu du 

système[12].  

Les Capteurs Solaires Thermiques à Stockage Intégré (CSTSI) sont des systèmes 

compacts ne nécessitant pas de tuyauterie, de réservoir de stockage séparé et 

d'autres composants. Sa structure compacte esthétiquement attrayante et son cout 
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de conception le moins chèr le rendant plus adapté en particulier dans les zones 

rurales [13]. Les CSTSI peuvent également réduire l'impact environnemental jusqu'à 

40%. Ces derniers utilisent la surface du réservoir de stockage comme absorbeur 

tandis que dans les autres systèmes, des composants séparés sont utilisés pour le 

chauffage et le stockage de l'eau [14].  

Dans ce contexte, nous avons mené une étude expérimentale qui consiste à  

réaliser un capteur solaire thermique plan à eau avec un système de stockage 

intégré, dont le matériau utilisé pour le stockage thermique est le sable fin, le choix 

du sable fin s’est imposé par le fait qu’on voulait utiliser un matériau disponible 

localement en abondance [15-18]. Le prototype a été testé sous des conditions 

réelles pendant une période de deux jours (hivernale et estivale). Les résultats 

obtenus en termes de rendement thermique (température de sortie) sont faible, ceci 

est dû à la masse élevée du sable fin utilisé suite à l’épaisseur du volume de stockage 

de 0.15m et au positionnement de l’échangeur thermique par rapport à la plaque 

absorbante (0.05m). Néanmoins, l’isolation thermique latérale et vers le bas du 

capteur ainsi que la température de la partie absorbante du capteur (plaque 

absorbante) et le comportement thermique du sable fin ont montrés de bon 

résultats, sachant que la température de la plaque absorbante maximale atteinte 

durant les deux jours d’essais est respectivement 370 K et 385 K et que le sable fin 

s’est comporté comme un bon amortisseur de température des paramètres d’entrée 

thermique ( fluctuations climatiques et défaut de manipulation) avec une énergie 

cumulée durant la journée hivernale et estivale respectivement de l’ordre de 118.72 

et 285.66 MJ. Ces avantages, nous ont conduit à poursuivre cette étude par la voie 

numérique  afin d’améliorer la température de sortie et l’amortissement des 

fluctuations de température sans affaiblir l’onde thermique.  

Dans le cadre de cette thèse, une étude paramétrique du capteur solaire 

thermique plan à eau avec un système de stockage intégré est réalisée à travers une 

étude numérique et fondée à partir d’une analyse expérimentale. 
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Le premier chapitre donne une synthèse sur la captation thermique à travers 

une étude bibliographique des différents types et techniques, ensuite, un état de l’art 

sur les capteurs solaires thermiques à stockage intégré déjà existant afin de 

comprendre les besoins et les défis de tels systèmes en se focalisant sur les 

améliorations apportées. 

Le deuxième chapitre est consacré dans un premier temps à l’environnement 

expérimental c. -à-d. la présentation du dispositif et l’installation complète, les 

mesures relevées, les appareils de mesure ainsi que le déroulement de 

l’expérimentation. Ensuite, on s’intéresse  à la formulation mathématique de tous les 

phénomènes physiques impliqués  dans le capteur solaire thermique à stockage 

intégré afin de bien comprendre le comportement thermique du prototype 

expérimental.  

Le troisième chapitre présente une étude numérique sous logiciel Ansys CFX  

du prototype expérimental où dans un premier temps, la configuration du modèle 

numérique basé sur des hypothèses, ensuite l’optimisation du modèle à travers une 

étude de sensibilité des résultats numériques au maillage, au pas de temps et donc le 

critère de convergence. Enfin, la validation du modèle numérique  par rapport aux 

résultats expérimentaux  donne accès à toute modification des paramètres pour 

l’optimisation du prototype expérimental.  

Le dernier chapitre expose les résultats de l’étude expérimentale à savoir la 

vitesse du vent, température ambiante, la température de sortie, la température 

dans le volume de stockage et une estimation du coefficient de perte et de la 

quantité de chaleur stockée durant les deux jours d’essai, ainsi que, les résultats 

numériques obtenus de l’étude paramétrique du capteur solaire thermique plan à 

eau avec un système de stockage intégré. 

Ce travail est clôturé par une synthèse qui regroupe les principaux 

aboutissements pour un choix optimal de configuration suivie de quelques 

recommandations permettant d’améliorer d’avantage notre prototype. 
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1.1 Introduction :  

 Les capteurs d'énergie solaire sont des échangeurs de chaleur un peu spéciaux qui 

transforment l'énergie du rayonnement solaire en une énergie thermique transportée 

par un fluide caloporteur. La principale composante de tout système solaire est le 

capteur solaire, il s'agit d'un dispositif qui absorbe le rayonnement solaire, le transforme 

en chaleur qui va transmettre à un fluide (généralement de l'air, l'eau ou l'huile) 

circulant dans le capteur. L'énergie solaire est recueillie à partir du fluide circulant, et 

transmise soit directement à l'équipement de conditionnement de l'eau chaude ou à un 

réservoir de stockage d'énergie à partir duquel elle peut être puisée pour utilisation 

durant la nuit et/ou les jours nuageux.  

Dans ce chapitre, différents types de capteurs solaires thermiques actuellement 

disponibles seront présentés ainsi que les capteurs solaires avec systèmes de stockages 

intégrés connu sous le nom de capteur solaire thermique avec stockage intégré et leurs 

technologies récentes. 

1.1.1 Contexte : 

Le cadre général de l'étude portera sur l'importance de l'utilisation des énergies 

renouvelables dans le contexte du changement climatique et de la crise énergétique liée 

à l'épuisement des énergies fossiles que nous devrons affronter. 

1.1.2 Changement climatique et énergies renouvelables : 

Les conséquences principales des activités humaines ont été l'augmentation 

constante de la consommation d'énergie et les rejets de gaz à effet de serre dans 

l'atmosphère, qui ont un impact sur l'environnement et le climat. Le cycle naturel du 

carbone sur terre est perturbé par l’effet  d’émissions de gaz à effet de serre, en 

conséquence, la température moyenne planétaire a augmenté de 1,1K entre 2015 et 

2019[19]. Face à l'épuisement des ressources, en plus de brûler des fossiles, des 
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méthodes alternatives de production d'énergie sont nécessaires pour faire face à 

l’épuisement des ressources. Si l'énergie provient d'un processus naturel, l'énergie est 

dite renouvelable c.-à-d. qu’elle est régénérée au même rythme ou plus rapidement 

qu'elle n'est utilisée. Ce processus naturel peut être, par exemple, l'énergie solaire, 

l'énergie éolienne, le courant de marée, la biomasse, etc. Cependant, malgré la tendance 

à la hausse évidente des énergies renouvelables, par rapport à d'autres ressources, elles 

sont encore rarement utilisées. 

1.2 Conversion thermique de l’énergie solaire : 

Dès que l’énergie lumineuse (photothermique) du soleil rencontre de la matière, 

elle en transforme une partie en chaleur, c’est ce qu’on appelle la conversion thermique 

exploitée directement, ou bien transformée indirectement en énergie mécanique, puis 

électrique. 

La conversion photothermique se fait à l'aide de collecteurs (capteurs) thermiques 

qui consistent en une transformation directe du rayonnement solaire en chaleur, utilisée 

pour le chauffage domestique, les cuisines solaires, la chaleur pour des processus 

industriels. La conversion se fait en deux manières : avec concentration et sans 

concentration. 

1.2.1 Chaine de conversion thermique: 

Un système solaire thermique est construit avec des composants qui 

convertissent l'énergie du rayonnement solaire en chaleur utilisable. La chaîne de 

conversion  d’énergie complète d'une  installation solaire thermique, est constituée d’un 

capteur, d’un fluide caloporteur et  d’un système ou milieu de stockage thermique. Dans 

cette chaine de conversion (voir Fig. 1.1) les photons du rayonnement solaire sont 

absorbés par l'absorbeur provoquant la vibration des atomes de l’absorbeur, ainsi, la 

température augmente dans l’absorbeur et la chaleur est produite. Une partie de cette 
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chaleur est transportée par conduction thermique de l'absorbeur à l’Échangeur 

Thermique « ÉcTh » dans lequel le fluide caloporteur circule, cette chaleur est rejetée 

vers le fluide caloporteur et transportée via un ÉcTh vers le stockage thermique avant 

qu’elle ne passe au consommateur. 

 
Figure 1.1: La chaîne de conversion énergétique de la chaleur solaire thermique [20] 

1.3 Capteur solaire thermique : 

Le capteur solaire est l’élément de base pour la transformation de l’énergie solaire 

en chaleur, le choix des capteurs solaire dépend de la température désirée de l’eau 

chaude et des conditions climatiques pendant la période d’utilisation du système. Il 

existe deux grandes familles de capteurs solaires thermiques ; capteur solaire thermique 

sans concentration et avec concentration. 

1.3.1 Capteur solaire thermique sans concentration : 

Le rayonnement solaire est capté par la surface absorbante du capteur solaire puis 

transformé en chaleur à basse température récupérée à l’aide d’un fluide caloporteur. Il 

existe plusieurs catégories de capteurs solaires basse température :  
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1.3.1.1 Capteurs sans vitrage : 

Une des plus simples façons d'utiliser l'énergie solaire  thermique est le chauffage 

des piscines en plein air, où le moment de la demande de chaleur et le rayonnement 

solaire disponible est plus ou moins corrélé. L’eau de la piscine  doit être chauffée à des  

températures relativement basses (un maximum d'environ 301.15K) [20,21]. 

Les capteurs utilisés sont constitués d'un tapis absorbant composé de tuyaux 

juxtaposés en caoutchouc souple très résistant et non couvert comme présenté dans la 

figure 1.2. Du fait de l'absence de vitrage, donc des pertes de transmission afférentes, ils 

possèdent un très bon rendement pour les températures proches de la température de 

l'air ambiant, ils ne permettent pas de produire d'eau chaude sanitaire. Ils sont très 

faciles à mettre en œuvre, l’utilisation de ces capteurs est  simple et peu coûteuse. 

 

Figure 1.2 : Schéma d’un capteur plan sans vitrage 

1.3.1.2 Capteur plan vitré : 

Le capteur plan vitré (voir Fig. 1.3) est le capteur le plus répandu et le mieux adapté 

aux besoins de chauffage et d’eau chaude sanitaire dans les bâtiments, sa température 

de fonctionnement correspond à la température de production de chauffage et d’eau 

chaude sanitaire lorsque les besoins sont plus importants. Ce type de capteur se 

présente sous forme de caissons de différentes dimensions sous forme d’éléments 

séparés ou monobloc. 

http://www.ines-solaire.com/solth/page22.html
http://www.ines-solaire.com/solth/page25.html
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Figure 1.3 : Schéma d’un capteur plan vitré 

 

1.3.1.3 Capteur solaire autostockeur : 

La caractéristique principale de ce type de capteur solaire (voir Fig. 1.4) est la 

combinaison des fonctions de captage et de stockage de l’énergie. Les capteurs solaires 

autostockeurs se présentent généralement sous la forme d’une enceinte vitrée sur le 

dessus, isolée au fond et sur les côtés, contenant un réservoir peint en noir [22].  

 

Figure 1.4: Capteur solaire autostockeur [23] 

Ce type de capteur est utilisé dans les pays à fort taux d’ensoleillement, leurs 

avantages s’expriment par une bonne productivité énergétique et une installation 

simple avec une maintenance réduite. Par contre, ils ont l’inconvénient des pertes 

nocturnes qui peuvent être importantes. 

 

             

         

           

             

        

http://www.ines-solaire.com/solth/page25.html
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1.3.1.4 Capteurs à tubes sous vide: 

Ce type de capteur solaire (voir Fig. 1.5) comporte plusieurs tubes de verre reliés en 

série renfermant chacun une canalisation de métal absorbant peint en noir, dans 

laquelle circule le fluide caloporteur. L’espace entre l’absorbeur et le tube de verre est 

vidé d’air. Comme le vide créé est un excellent isolant, le tube sous vide perd si peu de 

chaleur à l’air, il peut produire une eau à température plus élevée (jusqu’à environ 

423.15K) que les capteurs plans vitré, même pendant les grands froids d’hiver [26]. Les 

bonnes performances à haute température de ce type de capteur le destine 

normalement à des applications où des températures de fonctionnement élevées sont 

requises: production d’eau chaude pour l’industrie etc. Leur efficacité en fait le type de 

capteurs solaire à basse température le plus coûteux [25]. 

 
Figure 1.5: Schéma d'un capteur à tubes sous vide [26] 

1.3.2 Capteur solaire thermique avec concentration (Haute température) : 

Le solaire thermique à concentration est une idée ancienne qui est celle de la 

concentration du rayonnement solaire pour produire de la chaleur à haut niveau de 

température (supérieures à 393.15K). 
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Les capteurs à concentration utilisent l'énergie solaire arrivant sur une grande 

surface réfléchissante et réfléchie sur une plus petite surface avant qu'elle ne soit 

convertie en chaleur qui entraînerait de températures plus élevées. La contrainte 

principale, outre le coût des dispositifs plus élevé que celui des capteurs plans, est le 

système de poursuite destiné à suivre le soleil car ces derniers n'utilisent que 

l'irradiation directe donc ils doivent suivre le mouvement apparent du soleil. En 

conséquence, ils ne peuvent être installés que dans des zones fortement ensoleillées. 

Quelques types de capteurs à concentration sont présentés dans ce paragraphe : 

1.3.2.1 Concentrateur cylindro-parabolique : 

Comme son nom l’indique, ce système utilise une série de longs réflecteurs 

cylindriques en forme de parabole (voir Fig. 1.6). La parabole concentre la lumière sur un 

tube récepteur situé le long de la ligne focale du réflecteur. Les températures peuvent 

atteindre aisément les 773.15K et peuvent produire de la vapeur afin de fournir de 

l’électricité [26]. 

 
 

Figure 1.6: Schéma d'un capteur cylindro-parabolique [26] 

1.3.2.2 Réflecteur linéaire de Fresnel (RLF) :  

C’est une technologie qui s'appuie sur un réseau de bandes de miroir linéaire qui 

concentrent la lumière sur un récepteur fixe montée sur une tour linéaire. Le grand 

volume et le non déplacement des absorbeurs sont les conditions de construction de ce 
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dernier (contrairement aux autres capteurs ou l’absorbeur suit le mouvement du 

capteur).Une représentation d'un élément d'un champ de capteurs RLF est représentée 

sur la figure 1.7.  

Le plus grand avantage de ce type de système est qu'il utilise des réflecteurs plats 

ou des réflecteurs élastiques incurvés qui sont moins chers par rapport à réflecteurs 

paraboliques en verre. En outre, ils sont montés à proximité du sol, réduisant ainsi les 

exigences structurelles [27].  

 
Figure 1.7 : Schéma d'un récepteur éclairé par un champ RLF [28] 

1.3.2.3 Système à réflecteur parabolique: 

Un système à réflecteur parabolique représenté schématiquement à la figure 1.8,  

utilise des miroirs paraboliques pour concentrer le rayonnement solaire sur un récepteur 

situé au foyer du récepteur, ces systèmes peuvent atteindre des températures 

supérieures à 1737.15K [28]. Le récepteur contient un fluide qui, lorsque les rayons du 

soleil le frappent, atteint des températures très élevées. Ce fluide très chaud est ensuite 

utilisé pour produire de l’électricité dans un petit moteur (générateur) fixé au récepteur.  
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Figure 1.8 : Système à réflecteur parabolique [30] 

 

1.3.2.4 Héliostat (système de centrale à tour) : 

Le concept de système à collecteur central consiste à concentrer le rayonnement 

solaire à l’aide d’un champ de miroirs orientables (héliostats) sur un absorbeur situé en 

haut d’une tour (voir Fig. 1.9). Un dispositif  pompe un fluide caloporteur qui peut être 

une  huile synthétique ou du sel fondu dans l’absorbeur où il est chauffé à des 

températures entre 573.15 et 1737.15K et ensuite utilisé pour produire de l’électricité 

[28,29]. 

 
Figure 1.9 : Schéma d’une centrale à tour [30] 

 

 

Héliostats 
Tour 

Rayons du soleil 

Récepteur 
(collecteur) 

Rayons du soleil 



Généralité et Etat de l’Art sur la Captation Thermique et le Stockage Intégré 

 

26 

 

1.4 Classement des capteurs solaires thermiques à stockage intégré :  

La figure 1.10 montre les différentes configurations possibles de capteur solaire 

thermiques à stockage intégré. Trois grandes fonctions existent, la première, liée au 

stockage, elle offre la plus grande diversité liée aux composants internes et à 

l’enveloppe, puis la Couverture, a un rôle de protection de l’absorbeur vis à vis des 

déperditions thermiques et enfin la concentration du rayonnement solaire est 

envisageable avec différentes technologies comme les dispositifs paraboliques. 

 

Figure 1.10 : Classement des différents capteurs solaires thermique à stockage intégré [31] 

1.5 Histoire des Capteurs Solaires Thermiques à Stockage Intégré (CSTSI): 
 

Le premier CSTSI a été présenté à la fin du  XVIIIe siècle dans le sud-ouest des États-

Unis sous forme de réservoir exposé au soleil. Ces systèmes auraient produit 

suffisamment d'eau chaude par temps clair. Puis en 1891, Kemp a breveté le premier 

système commercial sous le nom «Climax», avec l'idée de le mettre en œuvre comme 

CSTSI. Dans ce système, un réservoir en métal était placé dans une boîte en bois et la 

partie supérieure de la boîte était recouverte d'un couvercle en verre. Le système a 

produit de l'eau chaude jusqu'à 311.95K par temps ensoleillé [32]. En 1902, Walker  a 
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proposé que le réservoir soit installé dans la zone focale d'un miroir de concentration, ce 

système était également équipé d'un chauffage à gaz de secours [33].  

Le premier CSTSI commercialisé avait quatre récipients cylindriques de forme ovale 

avec surface plane face au soleil, la taille et la forme du capteur ont eu un effet 

significatif sur la collecte d'énergie solaire. En outre, Haskell a proposé un remplacement 

des réservoirs tubulaires par d’autre plats placés à l'intérieur du boîtier du CSTSI pour 

obtenir une plus grande surface de captation, le réservoir était équipé d'ailettes pour 

obtenir un meilleur transfert de chaleur de la plaque absorbante [34]. 

1.6 Type des capteurs solaires thermiques à stockage intégré (CSTSI) : 

Le  paramètre qui impose le plus de contraintes au niveau du CSTSI est la forme du 

réservoir de stockage qui est généralement : rectangulaire, cylindrique, triangulaire, 

trapézoïdale et tubulaire. Nous allons montrer les CSTSI sans concentration avec 

réservoir de stockage rectangulaire, triangulaire et trapézoïdale. 

La continuité des recherches au sujet des CSTSI a conduit à l’amélioration et 

l’innovation  de nombreuses nouvelles conceptions. Différents CSTIS sont examinés et 

classés en fonction de leurs principes de captation et de stockage d'énergie. Ces 

systèmes peuvent être classés comme CSTSI sans concentration, avec concentration et  

avec matériaux à changement de phase comme matériau de stockage.  

 
1.6.1 Capteur solaire thermique plan avec un système de stockage intégré (cuve 

rectangulaire) (CSTPSSI) : 

Les CSTPSSI se caractérisent par l'intégration de la captation de l’énergie solaire et 

le stockage d’eau chaude dans une seule unité. Ces systèmes sont abordables et 

nécessitent moins d'espace d'installation [35].  

Gertzos et al ont étudié les CSTPSSI en modes de chauffage direct et indirect, en 

mode de chauffage direct, l'eau est chauffée directement dans le réservoir de stockage à 
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travers la plaque absorbante du capteur et en mode de chauffage indirect l'eau de 

service passe à travers un ÉcTh immergé dans l'eau chaude stockée [36].  

Al-Khalifajy et al ont analysé les performances d'un CSTPSSI indirect avec 

différentes conceptions d'échangeurs thermiques. Les résultats obtenus ont indiqué 

qu'un ÉcTh à une seule rangée pour les deux tubes de type B et elliptique donne une 

température d'eau de sortie plus élevée avec une meilleure efficacité thermique et des 

coûts opérationnels réduits[37]. 

Khalifa et Jabbar ont évalué les performances d'un CSTPSSI composé de six tubes 

en cuivre de 0.08m de diamètre extérieur connectés en série agissant à la fois comme 

absorbeur et réservoir de stockage (voir Fig. 1.11). Le capteur à simple vitrage de 

0.90m×1.80m de surface a été construit à partir d'un cadre en aluminium et incliné à 

45°, l'absorbeur a été placé à 0.03m sous la vitre. En termes d’efficacité instantanée, 

facteur d’efficacité du capteur et de facteur d'évacuation de chaleur, la configuration 

géométrique a montré des performances meilleures que les systèmes conventionnels 

[40].  

 

Figure 1.11 : CSTPSSI proposé par Khalifa et al [38] 

Récemment, Borello et al ont étudiés un CSTPSSI innovant composé de quatre 

tuyaux cylindriques (voir Fig. 1.12). Dans cet appareil, le capteur absorbe l'énergie solaire 

et soulève l'eau chaude vers le tuyau de sortie par convection et la rendait disponible sur 

le réseau domestique chaque fois que cela était nécessaire [39]. 
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Figure 1.12 : Schéma descriptif du CSTPSSI proposé par Borello [39] 

Taheri et al ont construit un CSTPSSI en tôle galvanisée compact et simple avec 

une surface de captation effective de capteur de 0.67m² et d'une taille de 

1.45×0.56×0.17m (voir Fig. 1.13). Deux modes d’écoulement convectifs d’eau (naturelle 

et forcée) ainsi que différentes orientations font l’objet d’analyse thermique de ce 

système. L’efficacité journalière moyenne pour l'orientation des capteurs vers le sud, 10° 

sud-est et 10° sud-ouest ont été estimées à 73.45%, 70.32% et 76.28%, respectivement 

et la valeur de température d’eau chaude stockée dans le réservoir atteint environ 

363,15K [40].  

 

Figure 1. 13 : Schéma du CSTPSSI compact proposé par Taheri [40] 
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Gertzos et Caouris ont étudié à l'aide d'un modèle CFD tridimensionnel le 

champ d'écoulement et le transfert de chaleur dans un CSTPSSI avec recirculation de 

l'eau de stockage. Puis, ils ont optimisé la position et la taille des orifices de 

recirculation ainsi que la taille et l'agencement des ailettes d'interconnexion (voir Fig. 

1.14) [41].  

 

 Figure 1. 14 : Schéma descriptif du CSTPSSI étudié par Gertzos et Caouris : (1) 
réservoir de stockage (2)ÉcTh(3) circulateur (4)entrée et sortie du fluide (5)entrée d’eau de 
service (6)sortie d’eau de service (7) ailette joignant les surfaces avant et arrière [41]  

Hazami et al ont fabriqué un système CSTPSSI constitué d'un échangeur 

capillaire intégré dans une matrice en béton avec une surface de captation de 5m² 

reposant sur un support en acier incliné à 45° (voir Fig. 1.15). Le caractère de stockage 

du système a fourni la chaleur nécessaire pour maintenir la température de l'eau du 

robinet à une température optimale [42].  
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Figure 1. 15 : Schéma de capteur solaire stockeur [42] 

Sopian et al  ont conçu un CSTPSSI non métallique et sans vitrage avec une 

capacité de stockage d'eau de 329L (voir Fig. 1.16). Toutes les parties du CSTPSSI ont 

été fabriquées à partir de polyester renforcé de fibre de verre en utilisant une 

composition de résine spéciale qui offre une bonne conductivité thermique et une 

bonne absorptivité, dix-neuf tubes collecteurs semi-elliptiques non vitrés 

d'absorbance 0.95 et une plaque absorbante de 3mm d'épaisseur de 1.4×1.8m de 

surface ont été utilisés. Les tests de performance du CSTPSSI avec et sans puisage  

nocturne de l'eau chaude ont indiqué que le système pouvait atteindre une efficacité 

de 45% pour une irradiation solaire de 635W/m2 et une température ambiante de 

304.15 K [43].  

 

Figure 1.16 : CSTPSSI proposé par Sopian et al [43] 

1.6.2 Capteur solaire thermique à stockage intégré de type coffre-réservoir : 

Garg a conçu et testé un chauffe-eau solaire à accumulation améliorée de type 

réservoir rectangulaire (voir Fig. 1.17), les résultats des tests ont indiqué que le 
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système atteignait une efficacité suffisamment élevée jusqu'à 70% et fournissait 

environ 90L d'eau chaude à une température comprise entre 323.15 et 333.15K en 

hiver et entre 333.15 et 343.15K en été[44]. 

 

Figure 1. 17 : Photo du chauffe-eau solaire à stockage intégré adapté à une utilisation rurale 

[44] 

Kumar et Rosen ont étudié un CSTPSSI de type réservoir avec une surface 

absorbante ondulée (voir Fig. 1.18), ce système  présente une température de 

fonctionnement plus élevée pendant une longue période mais avec une faible 

efficacité. La surface ondulée conduit à un élevée transfert de chaleur par convection 

plus élevée de l'absorbeur à l'eau et augmente également la surface exposée au soleil 

[45].  
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Figure 1. 18 : Coupe transversale d’un CSTPSSI  avec absorbeur ondulé [45] 

De plus, ils ont conçu un système à deux sections couplant un réservoir de 

stockage à une unité de stockage étendue (voir Fig. 1.19). La section ʺAʺ collecte 

l’irradiation solaire et la section ʺBʺ isolée stocke l'eau chaude. Un rapport volumique 

de VA/VB=7/3 a produit de l'eau chaude à une température suffisante avec une 

efficacité maximale [46].  

 

Figure 1. 19 : Coupe transversale du CSTPSSI modifié [46] 

Récemment, Saleh a fabriqué un réservoir rectangulaire de 1×1×0,03m (voir 

Fig. 1.20) en utilisant des matériaux de construction disponibles localement et 

raisonnablement bon marché. Dans ce système, la température de l'eau dans le 

réservoir atteint jusqu'à 333.15K et plus dans des conditions climatiques suivantes ; 

partiellement nuageuses, ensoleillées avec averses et ciel clair pendant les trois jours 
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sur quatre jours de test. Cependant, le système a produit de l'eau chaude à une 

température comparativement plus basse que les chauffe-eau solaires importés [47].  

 

Figure 1. 20 : Schéma du CSTPSSI proposé par Saleh [47] 

Mohsen et al ont étudié un CSTPSSI adapté pour fournir de l'eau chaude 

pendant 24h, les performances thermiques du système ont été évaluées à trois 

différentes profondeurs de la cuve (0.05, 0.10 et 0.15m) avec un simple et double 

vitrage (voir Fig. 1.21). Pour une profondeur de réservoir de 0.1m, le système a 

produit de l'eau chaude à une température plus élevée 241.15K que les autres 

profondeurs. De plus et pendant la nuit le système à double vitrage présente une 

puissance de rétention et température de l’eau  plus élevée [48]. 

 

Figure 1. 21 : Schéma descriptif du CSTPSSI étudié par Mohsen [49] 
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Dharuman et al ont construit un CSTPSSI pas chèr avec une surface absorbante 

de 1.3m² et une capacité de stockage d'eau de 170L (voir Fig. 1.22). Les résultats des 

tests ont indiqué que le système fournissait suffisamment d'eau chaude entre 318.15 

et 323.15K tôt le matin et que l'efficacité du capteur journalière et globale ont été 

observées à 60 et 40%, respectivement [50]. 

 

Figure 1. 22 : CSTPSSI proposé par Dharuman : (1) Vitrages, (2) plaque absorbante, (3) 
isolation du vitrage, (4) Circulateur, (5) réservoir de stockage, (6) isolation latérale, (7) 

chauffage, (8) réservoir d’alimentation d’eau, (9) vanne de remplissage, (10) sortie d’eau 
chaude, (11) miroir (12) flotteur [50] 

1.6.3 Capteur solaire thermique à stockage intégré triangulaire : 

Kaushik et al ont proposé capteur solaire thermique à stockage intégré 

triangulaire (voir Fig. 1.23). La conception triangulaire a amélioré le transfert de 

chaleur entre la plaque absorbante et l'eau et a également présenté un meilleur 

rendement global par rapport à une conception rectangulaire. La section triangulaire 

aide à obtenir un gain solaire plus élevé et un bon transfert thermique manifesté on 

convection naturelle éventuellement l’augmentation de température d’eau [51]. 
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Figure 1. 23 : Schéma descriptif du CSTSI triangulaire [51] 

1.6.4 Capteur solaire thermique à stockage intégré trapézoïdale : 

Cruz et al ont étudié les performances d'un capteur solaire thermique à 

stockage intégré de forme trapézoïdale (voir Fig. 1.24) avec un collecteur optimal 

incliné à 45°, la section transversale trapézoïdale a provoqué une parfaite 

stratification thermique dans l'eau stockée et a fourni un stockage d'énergie suffisant 

pour répondre aux demandes quotidiennes en eau chaude. Le système a permis 

d’économiser l’énergie de 30 à 70% et d’assurer une eau chaude de 304.15K pour 

une irradiation solaire globale de 600W/m² [52].  

 

 Figure 1. 24 : Coupe transversale d’un CSTSI de forme trapézoïdale [52] 
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1.7 Conclusion : 

En raison de la possibilité de fonctionnement passif, de la facilité d'installation, 

de la compacité du système et de l'emplacement de stockage derrière le capteur, il 

est particulièrement intéressant de choisir le capteur solaire thermique à stockage 

intégré pour la rénovation thermique. Par conséquent, aucun autre local pour les 

ballons n'est requis. Actuellement, les capteurs solaire thermiques à stockage intégré 

ne peuvent pas répondre à toutes les normes suivantes: esthétique, performance 

énergétique (réservoirs de stockage entièrement isolés) et légèreté. 
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2.1 Introduction : 

Dans cette partie, nous décrirons le dispositif expérimental ainsi que les 

différents équipements de mesure utilisés et le mode de fonctionnement suivi pour 

mener l'expérience. Certains travaux sur les capteurs solaires thermiques fournissent 

des bilans énergétiques sans préciser la nature de leur étude (expérimentation, 

simulation numérique ou étude théorique). De plus, ces travaux précisent rarement 

les caractéristiques du système étudié (sélectivité de l’absorbeur, épaisseur d’isolant, 

…). Donc, élaborer le modèle mathématique adéquat au système énergétique à 

réaliser, va nous permettre d’étudier le comportement dynamique de notre système 

et cela à partir des données acquises telles que ; les propriétés physiques des 

matériaux utilisés et des températures.  

 

Figure 2.1 : Photo du dispositif expérimental 

2.2 Descriptif de l’installation expérimentale : 

 L’installation expérimentale comprend trois parties comme indiqué dans la 

figure (2.2) : 

A- Capteur solaire thermique à eau avec un système de stockage intégré 

(dispositif expérimental) 
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B- Matériel de l’installation 

C- Kit solaire photovoltaïque. 

 

 

Figure 2.2 : Schéma de principe de l’installation solaire complète 

2.2.1 Dispositif expérimental :  

Le dispositif expérimental est un capteur solaire thermique plan à eau avec un 

système de stockage intégré, il est constitué essentiellement du haut en bas (voir 

Fig. 2.3) d’une couverture transparente à double vitrage en plaques de verre 

utilisé dans les habitations avec une surface 0.94×0.94m et une épaisseur de 

0.003m espacés de 0.016m pour assurer une isolation en avant et un rendement 

thermique optimal [53]. 

 

A 

B 

C 
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Figure 2.3 : Schéma descriptif du CSTPSSI 

L’indisponibilité de la tôle en cuivre et en aluminium nous a mené à utiliser la 

tôle en acier galvanisé  comme plaque absorbante, cette dernière a une surface 

effective de 0.9×0.9m et de 0.002m d’épaisseur et espacée de 0.02m par rapport à la 

vitre. Elle est repeinte à l’aide d’un pulvérisateur par une peinture noire mate (du 

commerce). Le réservoir de stockage intégré au bas du capteur avec dimension de 

0.9×0.9×0.15m, remplis avec du sable fin de dunes est en contact direct avec la 

plaque absorbante. Afin de récupérer l’énergie stockée dans le réservoir, un 

échangeur thermique en forme de serpentin est immergé dans le réservoir de 

stockage avec une profondeur de 0.05m par apport à la plaque absorbante. 

L’échangeur thermique est en cuivre de 0.0124m de diamètre intérieur et 0.014m de 

diamètre extérieur et de 6.23m de longueur, l’écart entre les tubes mesure 0.084m et 

l’écart entre les tubes et les parois d’isolation latérales mesurent 0.1m [54].  

Pour minimiser les pertes thermiques latérales et du fond, une isolation 

thermique   a été effectuée par deux matériaux en même temps [55], la laine de 

verre comme première couche de 0.01m d’épaisseur en contact direct avec les parois 

interne du coffre celle-ci limité par une autre couche de polystyrène expansé de 
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0.04m d’épaisseur enveloppe le réservoir de stockage. Le tout est chemisé dans un 

coffre en acier galvanisé dont deux de ces parois latérales sont perforées 

parallèlement pour qu’on puisse placer les deux bouts de l’échangeur thermique 

(entrée et sortie).Ainsi l’emplacement des thermocouples nécessite la perforation de 

l’une de ces parois même avec un diamètre qui correspond aux thermocouples. Le 

dispositif expérimental est fixé sur un support lui permettant une orientation et une 

inclinaison souhaité. 

Le schéma montré ci-dessous (voir Fig. 2.4 a-b) représente toutes les 

dimensions du dispositif expérimental. 

 

(a) 

            

(b) 

Figure 2.4 : Schéma dimensionnel du CSTPSSI :a) coupe transversale et b) coupe longitudinale 
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2.2.2 Matériel de l’installation : 

Les éléments (matériaux) décrits ci-dessus concernent seulement la réalisation du 

capteur solaire et pour procéder à l’étape des résultats, le dispositif réalisé doit être 

lié à une installation munie de  réservoir d’eau comme source d’alimentation, tube en 

plastique multicouches conçu spécialement pour être utilisé dans les installations 

d'eau potable et chauffage et vannes à des fins d’isolation en cas de maintenance. On 

a utilisé aussi un circulateur proposé sur le marché (de chauffage), ces circulateurs 

sont normalement conçus pour fonctionner à grands débits, par contre celui des 

installations solaires, présentent des débits plus faibles. 

2.2.3 Kit solaire photovoltaïque : 

Pour que notre installation soit totalement solaire et autonome on a introduit un 

kit solaire photovoltaïque pour faire circuler le fluide caloporteur. Ce kit est composé 

de panneau photovoltaïque monocristallin, un régulateur de charge/décharge 6A, 

onduleur (convertisseur) qui permettra de transformer le courant continu en courant 

alternatif et une batterie de 80Ah. 

2.3 Mesures à effectuer : 

On peut distinguer deux groupes de variables à mesurer d’une part les variables 

d’entrée du dispositif expérimental dont la température du fluide (eau) à l’entrée et 

la température ambiante, d’autre part les variables de sortie  dont la température du 

fluide à la sortie et les températures du volume de stockage (sable) à différent 

niveau. 

2.4 Appareillages de mesure:  

L’acquisition des données est faite à l’aide d’un thermomètre à affichage 

numérique avec une précision de ±0.1K et des thermocouples type K (chromel - 

alumel) sont utilisés pour mesurer les températures. Le dispositif expérimental est 



Expérimentation et Formulation Mathématique 

 

44 
 

équipé d’un total de 15 thermocouples, dont l’installation est représentée sur la 

figure 2.5 et figure 2.6. 

 

Figure 2.5 : Position des thermocouples dans le volume de stockage 

                                              

Figure 2.6 : Positionnement des thermocouples par rapport à l’épaisseur du volume de 
stockage 

Le premier thermocouple est fixé en proximité du dispositif expérimental afin 

de mesurer la température ambiante Tamb lors des acquisitions. Deux thermocouples 

installés : thermocouple 1 nommé (e) à l’entrée du capteur solaire et thermocouple 2 

nommé (s)  à la sortie du capteur solaire. Les douze thermocouples restant sont 

repartis dans le réservoir de stockage afin de mesurer la distribution de température  

à différentes profondeurs comme indiqué ; trois thermocouples T10. T12 et T14 repartis 

dans la partie basse du volume de stockage entre  l’isolation du fond (polystyrène) et 

l’échangeur thermique  à une profondeur égale à 0.1m(par rapport à la plaque 
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absorbante), puis cinq thermocouples T4, T5, T6, T7 et T8 placés sur l’échangeur 

thermique, ensuite trois T9, T11 et T13 thermocouples repartis dans la partie haute du 

coffre, c.-à-d. entre l’échangeur thermique et la plaque absorbante à une profondeur 

P=0.025m et enfin un thermocouple T3=TAbs est fixé au centre de plaque absorbante. 

2.5 Protocole expérimental : 

 Le dispositif expérimental est installé sur une terrasse d’habitation dont les 

coordonnées géographiques sont ; longitude L =2° 51ˊ 36˝ ; latitude, ϕ =33°47ˊ45˝ et 

altitude l=738m, ce dernier est orienté vers le sud (angle azimut a=0°) et incliné avec 

un angle β≈ϕ=34° par rapport à l’horizontale. 

 La procédure employée lors de l’exécution des essais est basée sur la mesure 

des températures, d’entrée Te , de sortie Ts , ambiante Tamb et en 12 points repartis 

dans le réservoir de stockage (voir Fig. 2.5 et Fig. 2.6). Ces mesures sont relevées 

manuellement à l’aide d’un thermomètre digital du lever au coucher du soleil avec un 

pas de temps de mesure de 10 minutes. L’état du ciel est le seul paramètre influant 

sur le choix du jour d’essai, car on a effectué douze essais durant les deux périodes 

hivernale et estivale et on a choisie deux (29 Janvier et 23 Juin).   

 Le fluide caloporteur utilisé est l’eau du robinet qui circule à l’aide d’un 

circulateur avec un débit constant ṁ=6×10-3kg/s afin d’éviter un fonctionnement 

sans circulation du fluide caloporteur, un réservoir de stockage d’eau alimente le 

CSTPSSI. 

2.6 Équations régissant l’équilibre énergétique du dispositif expérimental 

(CTPESSI): 

Certains ouvrages généraux sur l’énergie solaire proposent des bilans 

énergétiques, essentiellement sur les capteurs solaires thermiques, sans préciser la 

nature de leur étude (expérimentation, simulation numérique ou étude théorique). 

De plus, ces références précisent rarement les caractéristiques du système étudié 

(sélectivité de l’absorbeur, épaisseur d’isolant, …). Donc, élaborer le modèle 



Expérimentation et Formulation Mathématique 

 

46 
 

mathématique adéquat au système énergétique à réaliser va nous permettre 

d’étudier le comportement dynamique de notre système et cela à partir des données 

acquises telles que les propriétés physiques des matériaux utilisés et des 

températures. 

 

Figure 2.7 : Illustration du bilan thermique du CSTPSSI expérimental 

Le bilan est composé des flux énergétiques suivants : 

-  flux absorbé par la vitre 1 (N° 1dans la figure 2.7) 

-  flux radiatif échangé entre la vitre 1 et la voûte céleste (ciel) 2 

-  flux radiatif échangé entre la vitre 1 et le sol3 

-  flux convectif échangé entre la vitre 1 et l’ambiance extérieure 4 

-  flux absorbé par la vitre 25 

-  flux radiatif échangé entre la vitre 2 et la vitre 16 

-  flux convectif échangé entre la vitre 2  et la vitre 17 

-  flux absorbé par l’absorbeur8 

-  flux radiatif échangé entre l’absorbeur et la vitre 29  

-  flux convectif échangé entre l’absorbeur et la vitre 210 

-  flux conductif échangé entre l’absorbeur et  l’échangeur thermique 11 

-  flux conductif traversant l’isolant à l’arrière du capteur12 
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-  flux utile, soit la puissance évacuée par le fluide13 

 

 Figure 2.8 : Schéma électrique équivalent des échanges thermiques 

2.6.1 Échange convectif entre la vitre 1 et l’ambiance extérieure : 

Φv1-a
conv=hc,v1_a Av1(Tv1-Tamb) [58](2.1) 

hc,v1_a  : coefficient de convection naturelle entre la vitre 1 et le ciel 

Av1 : surface de la vitre 1 

Tv1 : température de la vitre 1 

Tamb  : température de l’ambiance extérieure 

 

2.6.2 Échanges radiatifs entre la vitre 1, le sol et la voûte céleste : 

L’expression du flux radiatif de la vitre 1 : 

Φv1-ext
rad = εv1σ0Av1Fv1,c(Tv1

4 -Tc
4) + εv1σ0Av1Fv1,sol (Tv1

4 -Tamb
4 ) (2.2) 

Avec :  

hr,v1_c=εv1σ0Av1Fv1,c(Tv1+Tc)(Tv1
2 +Tc

2) (2.3) 

 

hr,v1_a=εv1σ0Av1Fv1,sol(Tv1+Tamb)(Tv1
2 +Tamb

2 ) (2.4) 
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Fv1,c=
1+ cos β

2
  : facteur de forme entre la couverture et le ciel 

Fv1,s=
1- cos β

2
 : facteur de forme entre la couverture et le sol 

hr,v1_c  : coefficient d’échange radiatif entre la vitre 1 et le ciel 

hr,v1_a  : coefficient d’échange radiatif entre la vitre 1 et l’environnement 

extérieur 

Tc : température du ciel 

 : angle d’inclinaison du capteur 

εv1 : émissivité de la vitre 1 

σ0 : constante de Stéphane-Boltzmann, σ0= 5,67×10-8  W/ m2. K4 

2.6.3 Échange convectif entre la vitre 2 et la vitre 1: 

On exprime le flux convectif échangé entre la vitre 2 et la vitre 1 par la relation 

suivante: 

Φv2-v1
conv =hc,v2_v1 Av2(Tv2-Tv1) (2.5) 

Avec :  

hc,v2_v1=Nu
λair

ev2-v1

 (2.6) 

Nu=1+1,44 (1-
1708

Gr Pr cos ϑ
) [1-

1708(sin  (1,8 ϑ)1,6)

Gr Pr cos ϑ
] - 

[(
Gr Pr cos ϑ

5830
)

1
3⁄

-1] Si  0 ∗ 
[53](2.7) 

* = tan-1 (4800 Pr) (2.8) 

hc,v2_v1  : coefficient d’échange convectif entre la vitre 2 et la vitre 1 

Gr et Pr : nombres sans dimension de Grashof et Prandtl 

Av2  : surface de la vitre 2 (dans notre cas Av1= Av2) 

Tv2 : température de la vitre 2 

ev2-v1  : épaisseur entre la vitre 1 et la vitre 2 

λair : conductivité thermique de l’air 
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2.6.4 Échange radiatif entre la vitre 2 et la vitre 1 : 

Φv2-v1
rad = hr,v2_v1Av2(Tv2-Tv1) (2.9) 

Φv2-v1
rad =σ0Av2

(Tv2
4 -Tv1

4 )

1-εv2

εv2
+

1
Fv2,v1

+
1-εv1

εv1

 (2.10) 

Avec :  

 hr,v2_v1=σ0

(Tv2
2 +Tv1

2 )(Tv2+Tv1)

1
εv2

-1+
1

εv1

 (2.11) 

Fv2,v1= 1 : tout ce qui est émis par la face avant de la vitre 2 est  reçu par la vitre 1 

hr,v2_v1  : coefficient d’échange radiatif entre la vitre2 et la vitre 1 

εv2 : émissivité de la vitre 2 

 2.6.5 Échange convectif entre la plaque absorbante et la vitre 2: 

On exprime le flux convectif échangé entre la plaque absorbante et la vitre 2 

par la relation suivante : 

Φp-v2
conv=hc,p_v2Ap(Tp-Tv2) (2.12) 

Avec :  

hc,p-v2=Nu
λair

ep-v2

 (2.13) 

Nu=1+1,44 (1-
1708

Gr Pr cos ϑ
) [1-

1708(sin  (1,8 ϑ)1,6)

Gr Pr cos ϑ
] - 

[(
Gr Pr cos ϑ

5830
)

1
3⁄

-1] si  0  ∗ 
[53] 

(2.14) 

* = tan-1 (4800 Pr) (2.15) 

hc,p-v2  : coefficient d’échange convectif entre la plaque absorbante et la vitre 2 

Ap : surface de la plaque absorbante (dans notre cas AP= Av1= Av2) 

Tp : température de la plaque absorbante 

ep-v2  : épaisseur entre la vitre 2et la plaque absorbante 

λair : conductivité thermique de l’air 
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2.6.6 Échange radiatif entre la plaque absorbante et la vitre 2 : 

Φp-v2
rad = hr,p_v2Ap(Tp-Tv2) (2.16) 

Φp-v2
rad =σ0Ap

(Tp
4-T

v2

4
)

1-εp

εp
+

1
Fp,v2

+
1-εv2

εv2

 (2.17) 

Avec:  

hr,p_v2=σ0

(Tv2
2 +Tp

2)(Tv2+Tp)

1
εv2

+1+
1
εp

 (2.18) 

Fp,v2= 1  : car tout ce qui est émis par la face avant de la plaque absorbante est reçu 

par la vitre 2 

hr,p_v2  : coefficient d’échange radiatif entre la plaque absorbante et la vitre 2 

Tp : température de la plaque absorbante 

εp  : émissivité de la plaque absorbante 

2.6.7 Échange conductif entre le sable et le tube : 

Φp-t
cond=hd,p-tAst(Tt-Tp) (2.19) 

Avec :  

hd, p_t=
1

ep

λp
+

esab1

λsab
 + 

1
λt π Dt Lt

 
(2.20) 

hd,p_t  : coefficient d’échange conductif entre la plaque absorbante et le tube 

Ast  : surface de contact entre le tube et le matériau de stockage 

Dt,ext  : diamètre extérieur du tube 

Lt  : longueur du tube 

Tt   : température du tube 

ep : épaisseur de la plaque absorbante 

esab1 : épaisseur de la première couche du sable (esab1=0.05m) 

λp  : conductivité thermique de la plaque absorbante 

λsab  : conductivité thermique du sable 

λt  : conductivité thermique du tube 
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2.6.8 Échange convectif entre le fluide caloporteur et le tube: 

L’expression du coefficient d’échange par convection forcée dépend du régime 

d’écoulement. Le modèle prend en compte les trois régimes d’écoulement possibles : 

 Le régime laminaire  

 Le régime transitoire  

 Le régime turbulent 

Le coefficient d’échange par convection forcée, hcon,f-t , se calcule en fonction du 

nombre de Nusselt : 

hc,f_t=
Nu×λf

Dt

 (2.21) 

hc,f_t  : coefficient d’échange thermique par convection forcée entre le fluide et 

le tube 

λf    : conductivité thermique du fluide 

Dt   : diamètre intérieur de la conduite 

En régime laminaire, le nombre de Nusselt est donné par l’expression de Hausen [59]: 

Pour : Re < 2100 

Nu=3,66+
0.0668 ( 

Re×Pr×Dt

Lt
)

1+0.04 ( 
Re×Pr×Dt

Lt
)

2
3⁄

(
 μa 

μb

)

 0.14

 (2.22) 

Re et Pr : nombres sans dimension de Reynolds et Prandtl 

Lt  : longueur du tube 

μa  : viscosité dynamique de l’eau à la température considérée 

μb : : viscosité dynamique de l’eau au niveau de la paroi du tube à la 

température considérée 

En régime turbulent, le modèle utilise l’expression de Colburn [60]: 

Pour : 
Lt

Dt
>60; 0.7≤Pr≤100;  Re>104 

Nu=0.023×Pr1 3⁄ ×Re0.8 (
μa

μb

)

0.14

 (2.23) 

En régime transitoire, le modèle utilise l’expression de Sider-Tate [60] : 

Pour : 2100<Re<104 
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Nu=0.116(Re 2 3⁄ -125)Pr 1 3⁄ (1+ ( 
Dt

Lt

)
 2 3⁄

) (
 μa

μb

)
 0.14

 (2.24) 

2.6.9 Échange conductif entre le tube et le sable : 

Φsab2-t
cond =hd,sab2_t Ast (Tsab2-Tt) (2.25) 

Avec: 

hd, sab2_t=
1

esab2

λsab
+

1
λtπDtLt

 (2.26) 

hd,sab2_t  : coefficient d’échange conductif entre le sable 2 et le tube 

Tsab2  : température de la deuxième couche du sable 

esab2 : épaisseur de la deuxième couche du sable (esab2=0.1m) 

2.6.10 Échange conductif entre le matériau de stockage et l’isolation : 

Φi-sab2
cond =hd,i_sab2 Asab2(Ti-Tsab2) (2.27) 

Avec:  

hd,i_sab2=
1

esab2

λsab
+ 

ei1

λi1
+

ei2

λi2

 (2.28) 

hd,i_sab2  : coefficient d’échange conductif entre l’isolation et le sable 2 

Asab2  : surface de la couche inferieure du matériau de stockage (dans notre cas 

Asab2= AP= Av1= Av2) 

ei1  : épaisseur du premier isolant (polystyrène) 

ei2  : épaisseur du deuxième isolant (laine de verre) 

λi1 : conductivité thermique du premier isolant (polystyrène) 

λi2  : conductivité thermique du deuxième isolant (laine de verre) 
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2.6.11 Échange convectif entre l’isolation et l’environnement arrière du 

capteur : 

Le coefficient d’échange convectif est calculé, en fonction de la vitesse du vent 

(Vv), par la relation de Mc Adams [58] : 

hc,i_a=5,7+3,8Vv (2.29) 

Le flux convectif est déduit de (4.31) : 

Φi-a
conv=hc,i-a×Ai×(Ti-Ta) (2.30) 

hc,i_a  : coefficient d’échange thermique par convection entre le fond (isolation) 

et l’environnement extérieur 

2.7 Résolution du système d’équations : 

Selon le schéma électrique montré dans la figure 2.8, en applique la loi d’OHM  

au nœud de la maille, nous allons avoir les équations suivantes : 

2.7.1 Équilibre énergétique de la vitre 1 : 

Cv1

dTv1

dt
=Av1(hc,v1_a+hr,v1_sol)(Tamb-Tv1)+Av1(hc,v2_v1+hr,v2_v1)(Tv2-Tv1) 

+Av1(hr,v1_c)(Tc-Tv1) (2.31) 

Avec :   

Cv1= mv1.Cpv1 (2.32) 

Cpv1 : chaleur massique de la vitre 1 

mv1 : masse de la vitre 1 

2.7.2 Équilibre énergétique de la vitre 2 : 

Cv2

dTv2

dt
=Av2(hc,v2_v1+hr,v2_v1)(Tv1-Tv2)+Av2(hc,p_v2+hr,p_v2)(Tp-Tv2) 

+Av2 Pv2 (2.33) 

Avec :  

Cv2= mv2.Cpv2 (2.34) 

Cpv2 : chaleur massique de la vitre 2 

mv2   : masse de la vitre 2 
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2.7.3 Équilibre énergétique de la plaque absorbante : 

Cp

dTp

dt
=Ap(hc,p_v2+hr,p_v2)(Tv2-Tp)+Aphd,sable1(T1-Tp) (2.35) 

Avec :  

Cp= mp.Cpp (2.36) 

Cpp : chaleur massique de la plaque absorbante 

mp  : masse de la plaque absorbante 

2.7.4 Équilibre énergétique du tube : 

Ct

dTt

dt
=Aphd,p_t(Tp-Tt)+Asab2 hd,sab2_t(Tsab2-Tt)+ Ast hc, f_t(Tf-Tt) (2.37) 

Avec :  

Ct= mt.Cpt (2.38) 

Cpt : chaleur massique du tube 

mt  : masse du tube 

2.7.5 Équilibre énergétique du fluide : 

Cf

dTf

dt
=At hc,f_t (Tt-Tf) (2.39) 

Avec :  

Cf= mḟ .Cpf (2.40) 

At   : surface du tube 

Cpt : chaleur massique du fluide (l’eau) 

Dt,int : diamètre intérieur du tube 

ṁf  : débit massique du fluide 

                 2.7.6 Équilibre énergétique de la couche inferieure du matériau de 

stockage: 

Csab2

dTsab2

dt
=Asthd,sab2_t(Tt-Tsab2)+Asab2hd,i_sab2(Ti-Tsab2) (2.41) 

Avec:  

Csab2= msab2.Cpsab2 (2.42) 

Cpsab : chaleur massique du matériau de stockage 
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msab2 : masse de la couche inferieure du matériau de stockage 

2.7.7 Équilibre énergétique de l’isolation: 

Ci

dTi

dt
=Ai hd,i_sab2(Tsab2-Ti)+Ai hc, i_a (Ta-Ti) (2.43) 

Avec:  

Ci= mi1.Cpi1 +  mi2.Cpi2 (2.44) 

Cpi1 : chaleur massique du polystyrène 

Cpi2 : chaleur massique de la laine de verre 

mi1 : masse du polystyrène 

mi2 : masse de la laine de verre 
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2.8 Conclusion : 

Un certain nombre de contraintes sont apparues lors de la réalisation du 

CSTPSSI  dont le problème majeur est la non disponibilité des matériaux homologués 

pour ce genre d’étude. Cela nous a menés à utiliser des matériaux qui sont 

disponibles sur le marché local. Finalement le CSTPSSI réalisé est un capteur solaire 

thermique  plan à eau avec un échangeur thermique immergé duquel les 

caractéristiques suivantes :  

- Une isolation vers l’avant en double vitrage ; 

- Un revêtement non sélectif de la plaque absorbante ; 

- Le sable comme matériau de stockage.  

Le bilan énergétique établi pour chaque nœud, permettra de décliner un 

modèle mathématique décrivant le comportement dynamique du CSTPSSI. Si on veut 

évaluer théoriquement les puissances énergétiques (puissance absorbée, stockée, 

utile et perdue), les équations (2.31), (2.33), (2.35), (2.37), (2.39), (2.41) et (2.43) doit 

être discrétisées puis résolues par une méthode itérative (exemple : Gauss Seidel ou 

Jacobi) afin d’obtenir les coefficients d’échange thermique pour chaque pas de temps 

à partir des températures initiales supposées.   
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3.1 Introduction : 

 Le but de ce chapitre est de modéliser numériquement les transferts 

thermiques et l’écoulement du fluide caloporteur au sein du dispositif étudié 

expérimentalement(CSTPSSI). La modélisation et la procédure de résolution se font à 

l’aide d’un code CFD (ANSYS-CFX Workbench V19.R3). Les outils à disposition pour la 

simulation sont:  

- Design Modeler pour la géométrie.  

- Meshing pour le maillage. 

- CFX pour la résolution.  

- CFD Post pour le post traitement.  

Ensuite, on présente les différentes étapes de simulation CFD des transferts 

thermiques associés à l’écoulement du fluide caloporteur dans le système étudié 

(configuration, hypothèses et modélisation des échanges thermiques, maillage et 

optimisation…). 

 L’approche de modélisation appropriée pour le dispositif étudié est l’emploi 

des équations de conservation permettant le contrôle des phénomènes de transfert 

de chaleur couplé à l’écoulement du fluide caloporteur en régime laminaire. 

3.2 Généralités sur la CFD : 

 Une description d’une approche de modélisation numérique basée sur le bilan 

thermique des échanges thermiques a déjà été présentée dans le chapitre 2. Par 

conséquent, dans cette partie, nous nous concentrerons davantage sur les 

particularités liées au logiciel, et nous nous intéressons aux hypothèses utilisées 

retenues pour la simulation.  

 3.2.1 Maillage: 

 Le solver CFX (Computational Fluid dynamiX) est un logiciel basé sur la 

méthode des volumes finis capable de modéliser les écoulements des fluides et le 

transfert de chaleur pour les domaines comportant des géométries complexes. Il 
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s'agit d'intégrer les équations gouvernantes dans le volume de contrôle défini par la 

discrétisation spatiale du domaine (maillage) pour que les quantités voulues (masse, 

moment, énergie) seront conservées au sein de chaque volume de contrôle, c'est 

pourquoi la solution dépend de la qualité et de la taille du maillage[59]. Une 

illustration bidimensionnelle simplifiée des éléments et des nœuds utilisés par le 

solver est représentée dans la figure 3.1. Toutes les variables des équations résolues 

dans le modèle utilisé et les propriétés du fluide sont stockées aux nœuds. Cette 

méthode de résolution implique pour les problèmes bidimensionnels l’utilisation 

d’une maille dans la troisième dimension pour garder la même formulation (volume 

de contrôle).  

 

Figure 3.1 : Volume de contrôle [59  

 3.2.2 Méthodes de maillages : 

 Il est primordial de commencer l’opération du maillage par une configuration 

par défaut afin d’obtenir une première solution qui converge facilement puis 

appliquer des méthodes d’amélioration afin d’affiner les résultats. Le mailleur ICEM 

CFD dispose d’une similitude de méthode de maillages, les méthodes qu’on a 

utilisées sont : automatiques, dimensionnement et inflation, ces dernières sont 

appliquées en parallèle et en série durant les tests. L’utilisation correcte d’une 

méthode de maillage nécessite la prise en compte de plusieurs variables.  
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 3.2.3 Sensibilité au maillage : 

 La précision des résultats d’une étude dépend de la modification de certaines 

variables en fonction du nombre d’éléments, ces derniers sont affectés par la qualité 

du maillage, prenant en considération le temps de calcul engendré par cette qualité.  

Pour cette raison l’étude de sensibilité du maillage s’avère indispensable, en 

commençant par l’ajustement des paramètres globaux du maillage qui comprend : 

dimensions, lissage, raffinement et paramètres d’entrée…etc. Une fois la phase 

d’ajustement achevée, l’application de la méthode de maillage choisie peut être 

utilisée. 

 3.2.4 Pas de temps: 

L’autre facteur influant sur la précision des résultats est le pas de temps utilisé 

dans la simulation transitoire, son analyse se fait en même temps que l’étude de 

sensibilité au maillage. Pour cela, un compromis doit être trouvé entre le pas de 

temps (grand, petit) et la  durée de calcul afin d’éviter les erreurs. Le calcul du pas de 

temps est suggéré par guide d’utilisation de CFX [59] avec la fraction maillage-vitesse 

où le pas de temps peut être choisi par l’expression 3.3 : 

∆t =
L

U
 (3.3) 

Avec : 

L : longueur du domaine fluide m. 

U : vitesse moyenne m/s. 

3.3 Modélisation numérique : 

 Un modèle mathématique pour notre CSTPSSI soumis à des conditions réelles 

est proposé, ce modèle ne concerne que les échanges thermiques au sein du 

réservoir de stockage. 
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  3.3.1 Modèle physique : 

 Le dispositif expérimental est un capteur solaire thermique plan à eau avec un 

système de stockage intégré, constitué d’une couverture transparente à double 

vitrage et un ÉcTh en serpentin immergé dans le réservoir de stockage (remplis par 

de sable fin de dune) sous la plaque absorbante, tous ces éléments sont chemisés par 

une double isolation latérale et vers le bas. Le modèle physique étudié est représenté 

par la figure (3.2), constitué essentiellement d’un ÉcTh en serpentin assurant le 

transfert de chaleur vers le fluide caloporteur (eau), ce dernier immergé dans une 

cavité parallélépipédique rectangle qui représente le matériau de stockage (sable fin). 

Les dimensions et les propriétés thermophyiques du CSTPSSI étudié sont présentées 

respectivement dans les tableaux 3.1 et 3.2. 

 

 

  

 

Figure 3.2: Modèle physique, coupe transversale du CSTPSSI 

Cette étude vise à modéliser un système de stockage sensible utilisant le sable 

fin comme milieu de stockage. Ainsi, la configuration du réservoir de stockage permet 

d’assimiler le sable à un à un milieu solide [62].Un système représentatif du dispositif 

expérimental doit être défini avant d’entamer l’étape de modélisation. 

 

 

 

Interface Sable-Plaque Absorbante 

Échangeur Thermique Matériau de stockage 

(Sable fin) 

Cavité  

Fluide caloporteur (Eau) 
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Tableau 3.1 : Paramètres dimensionnels du CSTPSSI 

Paramètres Symbol Dimension (m) 

Longueur du parallélépipède Lvs 0.906 
Largeur du parallélépipède  Lvs 0.906 
Hauteur du parallélépipède Hvs 0.15 
Espace tube-face supérieure du parallélépipède Pt 0.05 
Diamètre extérieur du tube Dext 0.014 
Diamètre intérieur du tube Dint 0.0124 
Epaisseur du tube et 0.0008 
Espace entre deux tubes Wt 0.098 
Longueur du tube Lt 6.27 

Tableau 3.2 : Propriétés thermophysiques [61] 

Matériaux 
 

Masse 
molaire 

(Kg/ kmol) 

Masse 
volumique 

(Kg/m3) 

Viscosité 
Dynamique 

(kg/m.s) 

Chaleur 
spécifique 

(J/kg.K) 

Conductivité 
thermique 
(W/m.K) 

Sable fin 60.08 1515 / 800 0.27 
Cuivre  63.55 8933 / 3800 401.6 
Eau 18.02 997 8.89×10-4 4181.7 0.6069 

 3.3.2 Hypothèses simplificatrices : 

 Dans le but d’étudier le comportement thermique du CSTPSSI, un modèle est 

développé en se basant sur les hypothèses simplificatrices suivantes: 

 Le transfert de chaleur est unidirectionnel. 

 La distribution de la température  sur la plaque absorbante est supposée uniforme. 

 Les propriétés thermophysiques de l’eau et des composants du CSTPSSI sont 

considérées constantes. 

 Le sable fin est considéré comme solide isotrope. 

 La température initiale du sable est uniforme. 

 L’isolation thermique des parois latérales et du fond est parfaite (adiabatique). 

 3.3.3 Conditions aux limites et initiales : 

Aux frontières du domaine du calcul on, impose des conditions aux limites, ces 

dernières sont de trois types : la condition de Neumann décrite sous la forme                          

( ∇ ⃗ϕ=constante) ; la condition de Dirichlet où on considère que (φ= constante) et la 
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condition de Robin qui combine la condition de Neumann et la condition de Dirichlet.

 Suite à des contraintes de mesure et afin d’obtenir des résultats plus réalistes, 

les données climatiques des journées d’essais sont relevées dans deux sites, le 

second est le site expérimental où on a mesuré la température ambiante et l’autre 

site est la station météorologique où le paramètre à mesurer est la vitesse du vent. 

Les variations de la température ambiante et de la vitesse du vent sont 

illustrées dans la figure 3.3 et la figure 3.4 où la vitesse du vent évolue durant les 

deux journées avec une amplitude assez marquée durant la journée hivernale. On 

remarque que la vitesse du vent augmente et diminue avec le lever et le coucher du 

soleil, cette dernière est influencée par d’autres facteurs tel que : la météo, le terrain 

et les obstacles. 

 

Figure 3.3 : Évolution de la température ambiante et la vitesse du vent en fonction du temps 
(29 Janvier) 
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Figure 3.4 : Évolution de la température ambiante et la vitesse du vent en fonction du temps 
(23 Juin) 

3.3.3.1 Conditions aux limites : 

 La résolution numérique du modèle mathématique adopté dépend des 

conditions aux limites appliquées aux frontières du domaine. Les différentes 

conditions appliquées dans notre étude sont illustrées dans la figure 3.5, une 

condition de non glissement est appliquée sur toutes les parois. Les conditions aux 

limites sont comme suite : 

- La vitesse de l'eau à l’entrée : u= 0,014 m/s  

- La température de l'eau à l'entrée : Te = Te(t) 

- La température de l’absorbeur : Tabs = Tabs (t) 

- Les parois latérales et celle du fond sont adiabatiques : φ=0 

- Les pertes de charge sont négligeables. 

  

 

Figure 3.5 : Conditions aux limites 
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3.3.3.2 Conditions initiales :  

Une sélection appropriée des conditions initiales peut aboutir à une solution 

stable et une convergence accélérée. Les conditions initiales utilisées dans la 

simulation numérique sont tirées de l’expérimentation, ces paramètres sont 

appliqués de la même façon aux deux essais réalisés, et ils sont comme suit (voir 

Table. 3.3): 

Tableau 3.3 : Conditions initiales 

Paramètres  29 Janvier 23 Janvier 

Température d’entrée d’eau Te(t=0s) 283,55 K 297,75 K 

Température ambiante Tamb(t=0s) 283,25 K 297,05 K 

Température de la paroi supérieure du 

réservoir de stockage TAbs(t=0s) 
292,65 K 302,75 K 

Débit massique d’eau  mė = mṡ  (t=0s) 0.0061 Kg.s-1 0.0061 Kg.s-1 

3.4 Présentation du code de calcul CFX : 

CFX est un logiciel de simulation numérique d'écoulement en mécanique des 

fluides compressibles ou incompressibles, impliquant des phénomènes physiques 

complexes tels que la turbulence et le transfert thermique, les réactions chimiques, 

les écoulements multiphasiques, la cavitation, Il permet de mettre en œuvre une 

simulation numérique complète de la modélisation, de la création de géométries, et 

la visualisation des résultats, en passant par la création du maillage et le calcul. 

La modélisation numérique débute par la création de la géométrie sous le 

logiciel Design Modeler suivie par la génération du maillage dans ANSYS ICEM CFD et 

mise en place des conditions aux limites, en suite la configuration du problème sous 

le logiciel CFX-Pre, puis le calcul avec CFX SOLVER pour les différents cas retenus et 

finalement l’analyse des résultats obtenus dans CFD-POST (voir Fig. 3.6). 
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Figure 3.6: Structure générale d’ANSYS CFX [61] 

 3.4.1 Ansys Design Modeler « DM » : 

ANSYS Design Modeler est un modélisateur paramétrique basé sur des 

caractéristiques précises, conçu de manière à pouvoir commencer intuitivement et 

rapidement à dessiner et à modéliser des pièces en 3D. L’utilisateur est tenu de 

choisir un système de coordonnées afin de caractériser la géométrie. Il permet 

d’établir la géométrie du système étudié, cette géométrie peut être construite à 

partir de points servant à créer des lignes et ensuite des différentes surfaces et des 

volumes. 

 3.4.2 Ansys ICEM CFD :  

Répondant aux exigences en matière d’intégration d'outils génération de 

maillage pour l'analyse sophistiquée d'aujourd'hui, Ansys ICEM fournit des outils 

avancés de génération et d’optimisation de maillage. ANSYS ICEM est utilisé 

particulièrement dans des applications d'ingénierie telle que la CFD. Les outils de 
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génération de maillage d'Ansys ICEM offrent la possibilité de créer de manière 

paramétrique des maillages à partir de la géométrie dans de nombreux formats: -

Multibloc structuré-hexaédrique non structuré-tétraédrique non structuré…etc.  

ANSYS ICEM fournit un lien direct entre la géométrie et l'analyse ainsi que la 

géométrie qui peut être saisie à partir de n'importe quel format, qu'il s'agisse d'un 

package de conception CAO commercial, d'une base de données universelle tierce, de 

données de numérisation ou de données ponctuelles. Ansys ICEM offre la flexibilité 

de combiner des informations géométriques dans différents formats pour la 

génération de maillage.  

Les maillages structurés ou non structurés, la topologie, la connectivité inter-

domaines et les conditions aux limites qui en résultent sont ensuite stockés dans une 

base de données où ils peuvent facilement être traduits en fichiers d'entrée formatés 

pour un solveur particulier. 

3.5 Conception et maillage du CSTPSSI sous Ansys : 

 3.5.1 Création de la géométrie : 

La définition du problème à résoudre s’effectue à l’aide du préprocesseur 

Design Modeler, il permet de crée la géométrie du système et spécifier le type de 

matériau (fluide ou solide).  

Le CSTPSSI est composé de deux solides et un fluide, c. -à-d. un ÉcTh en 

serpentin en cuivre (voir Fig. 3.7) de 0.014m de diamètre extérieur Dext et de 0.012m 

de diamètre intérieur Dint et 6.27m de longueur Lt, puis, une cavité parallélépipédique 

contenant le matériau de stockage thermique avec une longueur Lvs de 0.906m et 

une largeur lvs de 0.906 m et une épaisseur evs de 0.15m. Le fluide caloporteur (eau)  
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(a)                                                 (b) 

 

(c) 

Figure 3. 7: Création de la géométrie sous DM des éléments du CSTPSSI : (a) ÉcTh, (b) fluide 
caloporteur – eau et (c) Volume de stockage 

Dans cette étape de simulation (création de la géométrie), la nomination des 

différents éléments de la géométrie est primordiale, car cette opération permet 

d’attribuer tous les paramètres liés aux conditions aux limites dans l’étape de 

configuration, par exemple ; indiquer les surfaces d’entrée et de sortie du fluide 

caloporteur dans l’ÉcTh est lés nommés respectivement ʺentrée–sortieʺ, nommer les 

surfaces latérales du volume de stockage et celle du fond par ʺparoiʺ, ensuite, 

nommer la surface supérieure du volume de stockage par ʺplaqueʺ. 

3.5.2 Génération du maillage :  

Vu à la complexité de la géométrie, le maillage couvrant tous les éléments du 

corps est hybride, il est  composé des éléments de nature différente ; prisme, 

hexaèdres et tétraèdres. La figure (3.8) illustre le maillage réalisé par ICEM CFD du 

volume de stockage, d’ÉcTh ainsi que du fluide caloporteur, ce maillage est généré 
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automatiquement sans avoir recours à aucune amélioration, nommé : maillage par 

défaut. 

Un rapport détaillé reflétant le déroulement du maillage est attribué 

systématiquement à la fin de chaque opération. Parmi ces détails, le nombre 

d’élément et le type de maillage sont listés au tableau (3.4). 

Tableau 3.4: Statistiques détaillées du maillage 

 
Éléments 

Géométrie des 
éléments 

Type de maillage 

Volume de stockage  290677 Tétraèdre  Non Structuré 

Echangeur thermique 5424 Hexaèdre structuré 

Fluide caloporteur 9770 Hexaèdre Hybride 

Capteur complet 3O5871 Tétra/Hexaèdre Hybride 

 

 

(a) 

  

(b) 
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(c) 

Figure 3.8 : Schéma du maillage ; (a) volume de stockage (b) ÉcTh et fluide caloporteur (c) 
capteur complet 

L’étape suivante consiste à définir les frontières (type de conditions aux 

limites) afin de faciliter l’affectation des données nécessaires dans l’étape suivante 

(CFX-Pre), puis définir les interfaces ou les surfaces de contact entre les matériaux 

(par exemple : interface tube-matériau de stockage et tube-fluide caloporteur). Une 

fois que ces opérations sont achevées, le maillage est généré et sauvegardé. 

3.6 Procédure de résolution numérique par « CFX » : 

Une fois que la géométrie est créé et les frontières sont définies, on exporte le 

maillage pour pouvoir effectuer une résolution numérique et discrétiser des 

équations de conservation de la masse, de la quantité de mouvement et de l’énergie 

intégrales (voir Fig. 3.9). Le module CFX-Pre permet de ; choisir le mode ou le type de 

résolution ; définir les  matériaux utilisés à partir de la bibliothèque interne ou bien 

par l’introduction d’un nouveau matériau ; configuration du domaine (solide et 

fluide) ; les conditions aux limites ; les termes sources; les paramètres de la solution 

parmi lesquels : le schéma de discrétisation, le résidu cible, le critère et le contrôle de 

convergence, enfin le contrôle de sauvegarde (voir Annexe. B).  

 



Modélisation et Mise en Œuvre Numérique 

 

71 
 

 

Figure 3.9 : Organigramme de la deuxième partie du pre-processing: définition de la 
modélisation physique et des paramètres numériques [62] 

3.7 Etude de sensibilité au maillage : 

Il faut d'abord déterminer les paramètres globaux du maillage, puis les 

appliquer par différentes méthodes disponibles qui seront testées. Cela permettra de 

choisir les paramètres de l’inflation imposée à la paroi interne du tube ainsi que la 

taille maximale de la maille. La précision de la solution est affectée par la meilleure 

qualité du maillage, cette dernière devient négligeable devant le temps de calcul 

énorme. Pour mener une étude dite de sensibilité, il faut démarrer d’un cas connus 

qui permettra de valider les paramètres du maillage. 

  A partir des conditions aux limites et initiales (citées précédemment) et en 

incluant le modèle laminaire et le pas de temps de calcul constant Δt=300s, on a pu 

définir quatre types de maillage dans la géométrie globale (volume de stockage, ÉcTh 
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et fluide caloporteur), du grossier  au plus raffiné en se basant sur les méthodes de 

maillages suivantes : par défaut, automatique, inflation et dimensionnement de la 

taille du corps. Le tableau 3.5 illustre les cas de maillage obtenus avec leurs détails 

pour chaque élément du CSTPSSI.  

Tableau 3.5 : Détails des diffèrent types de maillages 

 

 

Opération 
de Maillage 

Corps 
Forme 

d’Éléments 
Type de 
Maillage 

Nombre 
d’Eléments 

Globale 
Méthode de Maillage 

Temps 
de 

Calcul 
h :mn :s 

Nomination 
du Maillage 

1 

Volume de 
stockage 

Tétraèdre 
(+++) 

Non structuré 

305871 

Méthode par défaut : 

 Taille minimale 
de courbure 8mm 

 Taille 
maximale des éléments 
dans tous les corps 
40mm 

00 :47 :3
3 

M0.3 
Echangeur 
thermique 

Hexaèdre (+) Structuré 

Fluide 
caloporteur 

Hexaèdre(++) Hybride 

2 

Volume de 
stockage 

Tétraèdre 
(+++) 

Non structuré 

612073 

Méthode par défaut : 

 Taille minimale 
de courbure 5.3mm. 

Taille maximale des 
éléments dans tous les 
corps 40mm. 

00 :52 :3
9 

M0.6 Echangeur 
thermique 

Hexaèdre>Pris
me 
(++) 

Structuré 

Fluide 
caloporteur 

Hexaèdre(+) Hybride 

3 

Volume de 
stockage 

Tétraèdre  
(++) 

Non structuré 

918062 

Méthode utilisée : 

 Inflation : 
10 couches  d’une 
épaisseur maximale 
1mm 

 Dimensionnem
ent de la taille des 
éléments : 3mm 

1 :32 :44 M0.9 

Echangeur 
thermique 

Hexaèdre>Pris
me 
(+) 

Non structuré 

Fluide 
caloporteur 

Hexaèdre>Pri
sme> 
Tétraèdre 
(+++) 

Hybride 

4 

Volume de 
stockage 

Tétraèdre  
(++) 

Non 
structuré 

1115612 

Méthode utilisée : 

 Inflation : 
10 couches d’une 
épaisseur maximale 
1mm 

 Dimensionnem
ent de la taille des 
éléments : 2.5mm 

5 :15 :06 M1.1 
Echangeur 
thermique 

Hexaèdre>Pris
me 
(+) 

Non 
structuré 

Fluide 
caloporteur 

Hexaèdre>Pris
me> 

Tétraèdre 
(+++) 

Hybride 
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                         (a)                                        (b)                                             (c) 

  

   (d)                                       (e) 

Figure 3.10: Les différents maillages réalisés (volume de stockage, ÉcTh et fluide caloporteur) 

Il est à noter que pour tous ces maillages (illustrés dans la figure 3.10) leurs 

formes sont respectées sauf pour le maillage (a) et (b) où la forme carrée apparait 

pour le fluide caloporteur apparait, cela est dû à la méthode de maillage utilisée (par 

défaut et automatique) et on voit aussi que très peu d’éléments sont présents dans le 

fluide caloporteur reflétant la non utilisation du maillage très fin (inflation) près des 

parois du tube, ceci engendre une faible description du phénomène dans la zone 

(fluide caloporteur). Une autre observation distinctive peut être faite sur le maillage 

M1576916 (voir Fig. 3.10 (e)): l’épaisseur maximale des couches est de 2 mm au lieu 

de 1 mm pour les autre cas avec inflation (voir Fig. 3.10 (c) et (d)). Des problèmes de 

calculs apparaissent au-delà d’une épaisseur maximale de 2mm pré des parois dus à 

l’application de la méthode d’inflation dans les parois vis-à-vis. 

Une illustration du profil de température de sortie (Ts) est présentée dans la 

figure 3.11 pour les différents maillages listés dans le tableau 3.5. On observe que la 

tendance de la courbe expérimentale et les courbes de simulations sont bien suivies 

pour tous les types de maillages. Globalement, les courbes sont divisées en deux 

groupes ; le premier groupe représenté par les maillages M0.3 (par défaut) et M0.6 

dont elles superposent parfaitement au début et en fin de journée avec un écart 

M305871  M 612073 M 918062 

M 1115612 M 1577876 
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ΔTmoy(Texp, TM305871)=1.03K et ΔTmoy(Texp, TM612073)=1.44K presque uniforme de 11h30 

jusqu’à 14h30. Cependant le maillage élaboré automatiquement M0.3 illustré dans la 

figure 3.12 nécessite plus de raffinement au niveau du fluide caloporteur et 

précisément dans la couche pré-paroi. Ainsi, que l’écart observé en milieu de journée 

fait contradiction à l’hypothèse imposée et qui s’agit du non variation des propriétés 

thermophysiques des composants du CSTPSSI. Toujours dans le premier groupe de 

maillage et concernant le deuxième type M0.6, elle est aussi écartée suite à l’écart 

élevé en milieu de journée comparée à M0.3.  

 
Figure 3.11 : Profils de température de sortie pour différents maillages où Δt=300s (29 

Janvier) 

 

Figure 3.12: Vue globale et zoom du maillage type M0.3 

Le deuxième groupe de maillage représenté par les courbes M0.9 et M1.1 se 

superposent et reflètent parfaitement le phénomène thermique durant la journée 

avec un écart sous-estimé par rapport à la courbe expérimentale en fin de journée 
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avec un écart moyen ΔTmoy(Texp, TM918062)= ΔTmoy(Texp, TM1115612)=0.9K. On peut dire 

que ce deuxième groupe de maillage peut être utilisé pour la suite de la simulation, 

puisque les deux types de maillages (M918062 et M1115612) donnent les mêmes 

résultats, donc il faut introduire un autre paramètre de sélection qui est le  temps de 

calcul afin de l’optimiser. D’après le tableau 3.5 le choix est fait pour le type de 

maillage M0.9 nécessite donc un temps de calcul de 02:35:16. 

3.8 Étude de sensibilité au pas de temps :  

La qualité du maillage et le temps de calcul sont influencé aussi par le pas de 

temps de calcul, pour cette raison et dans cette section on a mené une étude de 

sensibilité au pas de temps de calcul. 

D’après la figure ci-dessous (voir Fig. 3.13), les pas de temps auquel on a 

introduit (200s, 300s, 600s) dans la configuration du M0.9 n’ont aucun effet sur la 

qualité des résultats, en revanche, le temps de calcul présenté dans le tableau 3.6 

diminue considérablement de 65% pour un pas de temps de 600s comparativement à 

200s. Dans ce cas le pas de temps de calcul idéal pour une durée de calcul 

relativement courte est 600s (nomination du modèle M0.9/600s). 

 

Figure 3.13: Profils de température de sortie pour différents pas de temps (29 Janvier) 
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Tableau 3.6 : Influence du pas de temps sur le modèle M0.9 

Type de 
maillage 

Pas de Temps 
Δt (s) 

Erreur (%) 
Temps de calcul 

(h :mn :s) 

M0.9 

200 0.42 2 :19 :52 

300 0.42 1 :32 :44 

600 0.42 00:48 :06 

 

3.9 Etude de sensibilité au critère de convergence : 

La modification du critère de convergence du modèle implique la diminution 

des instabilités et des erreurs, pour cela, dans cette section nous allons effectuer des 

modifications au niveau du nombre d’itération ainsi que les résidus.  

Le graphique de la figure 3.14 représente l’effet de modification du critère de 

convergence dans le modèle numérique M0.9 600s. Il est bien claire que la 

configuration du modèle avec un critère de convergence de 10-1 est écarté vu l’erreur 

engendrée de 2% (voir le tableau 3.7). Les trois autres critères de convergences 10-

2, 10-3 et 10-4 engendrent la même erreur de 0.43% avec une évolution dans le temps 

de calcul de l’ordre de 17.5% entre les critères de convergences 10-2 et 10-3. Dans ce 

cas le choix adéquat du critère de convergence repose seulement sur le temps de 

calcul minime égal à 00:48:06 qui correspond au critère de convergence 10-2. On peut 

nommer le modèle comme suit : M0.9/600s/10-2. 

 

Figure 3.14 : Profils de température de sortie pour différents critères de convergences (29 
Janvier) 
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Tableau 3.7 : Influence du critère de convergence sur le modèle M0.9 

Type de 
maillage 

Critère de 
convergence 

Erreur (%) 
Temps de calcul 

(h :mn :s) 

M0.9 

10-1 2 00 :40 :17 

10-2 0.43 00 :48 :06 

10-3 0.43 00 :58 :15 

10-4 0.43 00:57 :14 

 

La figure 3.15 illustre l’effet de modification du nombre d’itération sur les 

résultats de simulation. D’après ce graphique, les courbes issues de la simulation se 

superposent parfaitement ce qui reflète donc l’Independence du nombre d’itérations 

sur les résultats avec la même erreur de l’ordre de 0.43% (voir table. 3.8). En revanche 

et d’après le tableau 3.8, le nombre d’itérations a un effet sur le temps de calcul, 

prenons le cas de 2 itérations qui diminue de l’ordre de 31.5% par rapport à la durée 

maximale représentée par 3 itérations. 

 

Figure 3.15: Profils de température de sortie pour différents nombres d’itérations (29 Janvier) 

Tableau 3.8: Influence du nombre d’itérations sur le modèle M0.9 

Type de 
maillage 

Nombre  d’itérations Erreur (%) 
Temps de calcul 

(h :mn :s) 

M0.9 

2 0.43 00 :48 :06 

3 0.43 01 :10 :29 

4 0.43 00 :57 :19 

5 0.43 00:59 :22 
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3.10 Comparaison entre les résultats de simulation et expérimentaux : 

L’analyse menée dans les sections précédentes nous a conduit à développer un 

modèle numérique qui satisfait ; la qualité du maillage ; le pas de temps ; le critère de 

convergence ; le nombre d’itération ainsi que la durée l de calcul.  

Les figures 3.16 et 3.17 montrent une comparaison graphique entre les 

résultats obtenus en termes de profils de température de sortie durant les deux jours 

d’essai (29 Janvier et 23 Juin) du lever au coucher du soleil. Les résultats obtenus par 

simulation correspondent bien à ceux expérimentaux. Le modèle numérique 

développé a bien reproduit le phénomène thermique avec un écart de température 

moyen de l’ordre de 0.95K et 0.47K vers la fin de journée pour le 29 Janvier et le 23 

Juin respectivement, cet écart peut s’expliquer par le fait que les propriétés 

thermophysiques des matériaux utilisés ( sable et cuivre) ne sont pas conformes aux 

celles réelles et que le phénomène des tourbillons dans les zones courbées de l’ÉcTh 

n’est pas pris en compte par la simulation puisque on a imposé le régime laminaire.  

 

Figure 3.16: Comparaison de la variation de la température de sortie expérimentale et 
simulation (29 Janvier) 
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Figure 3.17 : Comparaison de la variation de la température de sortie expérimentale et 
simulation (23 Juin) 

3.11 Conclusion : 

En conclusion, la validation de notre modèle numérique a fait l’objet de 

plusieurs test afin d’obtenir une configuration qui simule au mieux les transferts 

thermiques et l’écoulement du fluide dans le CSTPSSI étudié.  

En premier lieu, on a varié les paramètres de maillage afin de mailler 

correctement la géométrie, cette étape est réceptionnée par la sélection du type de 

maillage M0.9. Ensuite, on a choisi le pas de temps qui est le mieux adapté à notre 

modèle, il s’est avéré que le pas de temps 600s est le mieux adapté car il minimise le 

temps de calcul sans affecter les résultats.  

Enfin, on a analysé l’effet de modification du critère de convergence et le 

nombre d’itérations sur la précision, la stabilité et le temps de calcul, ceci est finalisé 

par le choix du critère de convergence de 10-2 avec deux itérations de calcul pour 

chaque pas de temps. « M0.9/29Ja/600s/10-2/2 » et« M0.9/23J/600s/10-2/2 » sont les 

choix nominaux du modèle numérique qui est utilisé pour le reste des simulations. 

On peut s’assurer donc, que le modèle développé servira d’outil de calcul valide pour 

l’étude objet de cette thèse. 
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 4.1 Introduction : 

Après avoir validé le modèle numérique dans le chapitre précédent, ce 

chapitre a pour objectif de présenter dans un premier temps, les résultats obtenus de 

l’expérimentation. Ces résultats expérimentaux feront l’objet de base de données 

permettant de décrire les paramètres influant sur le comportement thermique du 

CSTPSSI expérimental, durant une période d’essai qui ’s’étale en deux jours (hiver et 

été). Ensuite, nous allons réaliser une série de simulations pour étudier l’influence de 

l’épaisseur du volume de stockage qui intègre le sable, le positionnement de l’ÉcTh 

dans le volume de stockage. 

4.2 Paramètres mesurés expérimentalement : 

4.2.1 Évolution de la température de la plaque absorbante et la température 

ambiante :  

La figure 4.1 représente la variation de la température de la plaque absorbante 

et la température ambiantes en fonction du temps local durant la journée du 29 

Janvier. La température ambiante varie avec le temps (Tamb=282.65, 291.85K) par 

contre la température de la plaque absorbante augmente et puis diminue avec 

l’apparition du soleil, elle atteint son maximum Tabs=370,15K=97°C à 14h20, 

théoriquement cela n’est pas possible car l’énergie solaire incidente est à sa valeur 

maximale à midi solaire (TSV=12h) qui  correspond à 12h46 en temps local, ce 

décalage de temps est imposé par des fluctuations qui apparaissent sur la courbe Tabs. 

Durant cette journée des perturbations ont été observées (en début de journée, à la 

mi-journée et en fin de journée). Ces perturbations  s’expliquent par la présence des 
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nuages qui induisent des variations de la température de la plaque absorbante. 

 

Figure 4.1 : Variation de la température de la plaque absorbante et la température ambiante 
en fonction du temps (29 Janvier) 

 

La figure 4.2 représente la variation de la température de la plaque absorbante 

et la température ambiante en fonction du temps local durant la journée du 23 Juin. 

La température de la plaque absorbante atteint son maximum Tabs =385.15K=112°C à 

13h50 en temps local correspond à 12h51 en temps solaire vrai et la température 

ambiante varie avec le temps (Tamb =297.05, 309.85K). La courbe Tabs est uniforme 

avec une symétrie par rapport au temps local (à TL=13h50), aucune perturbation 

n’apparait sur la courbe Tabs ce qui signifie que le ciel est très clair.  
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Figure 4.2 : Variation de la température de la plaque absorbante et la température  
ambiante en fonction du temps (23 Juin) 

4.2.2 Variation des températures entrée et sortie du CSTPSSI : 

La figure 4.3 représente l’évolution des températures expérimentales entrée 

et sortie du CSTPSSI en fonction du temps local durant la journée du 29 janvier, et ce 

du lever du soleil à 8h10 jusqu’à son coucher à 18h10 pour une durée de 10 heures. 

Les deux courbe ont la même allure avec un écart de température qui ce diffère 

d’une moyenne de ΔTmoy=1K au début de fonctionnement jusqu’à 12h30 et ΔTmoy=4K 

jusqu’à la fin du fonctionnement. Dès le début de fonctionnement jusqu’à 11h40, 

dans cet intervalle l’écart de température ΔT=1K s’étale sur une durée importante 

par rapport à la durée du jour pendant 4 heures et 20 minutes, cela est justifié par ; 

l’inertie thermique élevée du CSTPSSI et précisément du sable, cette dernière peut 

être interprété comme une mesure de la masse thermique et de la vitesse à laquelle 

l’onde de chaleur est transmise à travers le matériau [63]  on peut dire que la totalité 

d’énergie absorbée par le CSTPSSI se dissipe dans le sable pour uniformiser sa 

température ; la température d’entrée d’eau au CSTPSSI est presque la même que 

celle du sable (à la même profondeur), ce qui ne favorise pas le transfert thermique 

par conduction et par convection entre le sable, l’ÉcTh et l’eau, cela est dû à la source 

d’alimentation en eau qui est totalement exposée à l’ambiance extérieure, l’eau subit 
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tous les changements météorologiques avant de pénétrer dans le CSTPSSI. Puis, de 

11h40 jusqu’à 14h40, le système commence à fonctionner avec une légère 

augmentation de l’écart de température (1≤ΔT ≤4K). La température de sortie atteint 

son maximum Ts max= 22K aux environs de 14h40.  

 

Figure 4.3: Évolution des températures entrée et sortie du CSTPSSI (29 Janvier) 

Une partie de l’énergie absorbée par le CSTPSSI sert à augmenter la température 

du sable par conduction. Cela reflète la phase de stockage thermique, au fur et à 
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l’augmentation de la température du fluide. Enfin, de 14h40 jusqu’à la fin du 

fonctionnement, l’écart de température est presque stable (ΔT=4K) avec une 

diminution sensible de la température de sortie, la stabilité de l’écart de température 

est assurée par le déstockage thermique du sable, celui-ci se présente comme source 
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courbes coïncident parfaitement pour une durée de 3 heures et 40 minutes (même 

comportement thermique que celui du 29 Janvier). Ensuite de 10h10 jusqu’à 17h20, le 

CSTPSSI commence à fonctionner normalement avec une légère augmentation 

d’écart de température (1K ≤ ΔT ≤ 3K), la température de sortie atteint son maximum 

Ts max= 309.45K aux environs de 15h10, une perturbation apparait dans cet intervalle 

est  abaisse la température d’entrée et de sortie du CSTPSSI en gardant le même 

écart de température, cette perturbation dure 4 minutes, elle est due à une erreur de 

manipulation technique (épuisement d’eau stockée dans le réservoir qui est 

remplacée par l’eau du réseau d’alimentation principale qui a une température 

inférieure à celle du réservoir exposé à la température ambiante). Enfin, de 17h20 

jusqu’à la fin du fonctionnement, l’écart de température est presque stable (ΔTmoy= 

3K) avec une diminution sensible des températures entrée et sortie du CSTPSSI.  

 

Figure 4.4: Évolution  des températures entrée et sortie du CSTPSSI (23 Juin) 
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4.2.3 Variation de la température dans le volume de stockage: 

La figure (4.5) représente les évolutions de la température dans le volume de 

stockage  à différentes profondeurs et la température de  la plaque absorbante 

durant la journée du  29 Janvier de 8h10 à 18h10. 

A partir de cette figure on peut distinguer deux faisceaux de courbes qui 

varient avec celle de la plaque absorbante. Les courbes de chaque faisceau ont la 

même allure, cela signifie qu’on a une répartition thermique uniforme dans le sable. 

La température du sable aux points 9, 11 et 13 à une distance P1=0.025m de la plaque 

absorbante (voir Fig. 4.6) varient au même rythme que la température de la plaque 

absorbante au point 3  dont T3=Tabs avec un faible écart de température au début et 

en fin de journée, il est en effet assez considérable en milieu de journée. Le sable 

atteint une température maximale  T9 max ≈T11 max ≈T13 max ≈322.15K à 14h40 alors que 

celle de la plaque absorbante Tabs max= 370.15K à 14h20, soit un décalage de temps 

(Δt=20 minutes) entre ces deux pics, c'est-à-dire que la quantité de chaleur reçue par 

la plaque absorbante stockée dans le sable sera restituée avec un retard de 20 

minutes (le signal émis par la plaque absorbante met 20 minutes pour parcourir une 

épaisseur de 0.025m de sable), ce décalage de temps est appelé le déphasage. Les 

fluctuations figurées sur la courbe Tabs n’apparaissent pas sur l’ensemble des courbes, 

cela est dû au phénomène de diffusion.  

Le deuxième faisceau qui représente les températures aux points 10, 12 et 14 à 

une distance P2=0.1m de la plaque absorbante peut être étudié sur deux intervalles 

de temps, de 8h à 11h, la température du sable (P2=0.1m) est en diminution légère 

avec une pente négative de 3%, cela est traduit par le déstockage de l’énergie 

thermique stockée la veille du jour de l’essai (le CSTPSSI est exposé au soleil sans 

circulation du fluide). De 11h jusqu’à la fin de fonctionnement, la température du 

sable ne cesse d’augmenter malgré la diminution de la température de la plaque 

absorbante  avec une pente positive identique à celle du déstockage sauf que cette 

dernière représente le stockage thermique. L’écart de temps entre les deux pics de 

température (plaque absorbante et sable à P2=0.1m) est assez étendu (Δt≥340 
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minutes) par rapport à celui entre la plaque absorbante et le sable à P1=0.025m, donc 

le déphasage de la couche inferieure du sable est plus fort avec une amplitude 

thermique faible alors que celui de la couche supérieure du sable a un déphasage 

faible avec une amplitude thermique forte.  On peut dire que la couche du sable qui 

se situe entre la plaque absorbante et l’ÉcTh (esab1=0.05m) se comporte comme une 

plaque absorbante sauf que sa température diminue proportionnellement à 

l'éloignement par rapport à la plaque absorbante et en même temps elle amortie les 

perturbations liées aux changements climatiques (principalement les nuages). 

 

 

Figure 4.5 : Distribution de la température dans le volume de stockage (29 Janvier) 

 

Figure 4.6 : Positionnement des thermocouples (plan longitudinal) du CSTPSSI solaire 
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La figure 4.7 illustre les évolutions de la température dans le volume de 

stockage  à différentes profondeurs (P1= 0.025m et P2= 0.10m) et de la température 

de la plaque absorbante pour la journée du  23 Juin de 6h30 à 20h. D’après cette 

illustration on peut dire que le sable a le même comportement thermique que celui 

du 29 Janvier, le seul changement est que la température du sable (T9, T11, T13, T10, T12 

et T14 ) augmente avec un écart ΔT=20K qui est lié à l’augmentation de la température 

de la plaque absorbante. 

 

Figure 4.7 : Distribution de la température dans le volume de stockage (23 Juin) 

4.3 Estimation du coefficient de perte de thermique: 

Les figures 4.8 et 4.9 montrent l’évolution des coefficients de perte thermique  

total Utotal, vers l’avant Uav, vers l’arrière Uar et latéral Ulat en fonction du temps 

durant les deux jours d’essais. Le coefficient Uav est calculé à l'aide de l'équation 

empirique développée par Klein (voir Annexe A)  [64]. L'augmentation de la 

température de la plaque absorbante entraîne une augmentation des pertes 

thermiques globales et vers l’avant en raison de l'augmentation des pertes par 

convection et par rayonnement [65]. Le coefficient Ulat est très faible par rapport à 

Uar suite au petit rapport périmètre / surface de CSTPSSI. 
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Figure 4.8 : Variation des coefficients de pertes thermiques du CSTPSSI expérimental 
(29 Janvier) 

 

Figure 4.9 : Variation des coefficients de pertes thermiques du CSTPSSI expérimental 
(23 Juin) 

4.4 Estimation de l’énergie thermique stockée: 

Les figures (4.10) et (4.11) montre la variation de l’énergie thermique stockée 

dans le sable et la température de la plaque absorbante en fonction du temps durant 

les deux jours d’essai. Nous pouvons distinguer le processus de stockage d'énergie 

thermique (calculé par la méthode trapézoïdale)[54] dans le sable en fonction des 

intervalles de temps, de 8h20 à 10h40 pour la journée du 29 Janvier et de 6h30 à 8h00 
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pour la journée du 23 Juin, la chaleur stockée se manifeste par des valeurs négatives,  

cela se traduit par le processus de décharge [66], c'est-à-dire que l'énergie stockée la 

veille de l’essai dont le circuit fermé a été rétablie pendant une période de 2 heures 

et 20 minutes. 

  

Figure 4.1O : Évolution de l'énergie thermique stockée et de la température de la 
plaque absorbante (29 janvier) 

            

 Figure 4.11 : Évolution de l'énergie thermique stockée et de la température de la plaque 
absorbante (23 juin) 
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exposée à l'environnement) par rapport à la température du sable, ainsi qu’à  

l'augmentation de la température du sable de la couche inférieur par rapport à la 

couche supérieure. Tout cela augmente la chaleur emmagasinée, ce qui reflète le 

processus de charge à court terme. La fin de ce premier intervalle pour les deux 

essais le CSTPSSI atteint l'équilibre thermique (Qst=0J). 

De 10h40 à 14h40 le 29 Janvier et de 8h00 à 15h00 le 23 Juin, la chaleur stockée 

augmente malgré la circulation de l’eau dans l'ÉcTh, cette période représente le 

processus de charge, la fin de cette période reflète le processus de stockage où la 

chaleur stockée reste presque constante pendant près d'une heure malgré la baisse 

de la température de la plaque absorbante, ce qui signifie que le sable continu 

d'accumuler de l'énergie jusqu'à la température de stagnation. Le processus de 

décharge est la dernière étape qui poursuit jusqu'à la fin du fonctionnement, où le 

système de stockage (sable) a restauré l'énergie stockée pour assurer le 

fonctionnement l'après-midi.  

4.5 Etude paramétrique : 

Une fois le modèle numérique est validé, l’optimisation du CSTPSSI 

expérimental est envisagée. Dans cette étude paramétrique, nous présenterons la 

démarche à suivre avec la simulation durant les deux jours d’essai, dont l’épaisseur 

du volume de stockage et le positionnement de l’ÉcTh ainsi que le matériau de 

stockage sont les paramètres à varier, leurs valeurs sont listées dans le tableau 4.1..  
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Tableau 4.1 : Valeurs des variables à etudier 

Epaisseur du volume de 
stockage evs(m) 

Positionnement de l’ÉcTh Matériau de 
stockage 

0.025 

Haut Sable 

Milieu Sable  

Bas Sable  

0.020 

Haut Sable  

Milieu Sable  

Bas Sable  

0.014 Ajusté 
Avec et sans 

sable 

 

4.5.1 Epaisseur du volume de stockage evs =0.025m: 

La  Figure 4. 12 représente la variation de la température de sortie des trois 

positionnements de l’ÉcTh (Bas, Milieu et Haut) avec une épaisseur du volume de 

stockage evs=0.025m durant la période hivernale (29 Janvier).  

Les trois courbes ont la même allure avec différentes amplitudes qui varient 

avec le positionnement de l’ÉcTh (en Bas, Milieu et Haut). L'effet de la température 

de l'eau d'entrée sur la température de sortie est très faible et limité au début de 

journée dont le CSTPSSI est au régime transitoire restreint seulement. Une 

augmentation de la température de la plaque absorbante entraîne une augmentation 

de la température de sortie. Les résultats montrent que le pic de température de 

sortie augmente avec l'élévation de la température de la plaque absorbante. Il est 

claire que la configuration en haut où l’ÉcTh est en contact direct avec la plaque 

absorbante atteint une température maximale Ts Haut= 330.88K qui coïncide 

parfaitement au moment où la plaque absorbante atteint Tabs=370.15K à 14h20 par 

contre les deux  autres configurations du Milieu et du Bas affichent des températures 

maximales de 308K et 302.8K respectivement avec un déphasage Δt=10mins. Les 

deux courbes (Milieu et Bas) sont confondues au début pendant Δt=70mins, cela est 

justifié par l’inertie thermique du sable qui ralentit le fonctionnement du CSTPSSI 

(l’énergie absorbée par le CSTPSSI se dissipe dans le sable pour uniformiser sa 
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température), en même temps, c’est une part d’énergie qui est stockée dans le sable. 

Pour le cas où l’ÉcTh est en haut, une partie de l’énergie solaire absorbée est 

utilisée pour le chauffage de l’eau à travers les ponts entre la plaque 

absorbante et l’ÉcTh et l’autre partie est utilisée par le sable à travers le 

périmètre de l’ÉcTh, tandis qu’aux autres cas, du milieu et du bas, l’énergie 

thermique est transférée au sable (assurant l’amortissement de température 

pendant la charge et décharge en même temps), puis vers l’ÉcTh.  

 

Figure 4.12 : Évolution de la température de sortie des trois configurations (bas, milieu et 
haut)  pour une épaisseur evs=0.025m (29 Janvier)   

La figure 4.13 illustre bien les fluctuations thermiques traduites en écarts de 

température des paramètres d’entrées et de sorties  du CSTPSSI, deux  fluctuations 

assez marquantes apparaissent à 9h10 et 13h10 dans la courbe de de chaque 

configuration avec différentes amplitudes. Elles sont de l’ordre de 5.2K et 6.5K 

respectivement. Au niveau du CSTPSSI, ces fluctuations sont interprétées par des 

signaux thermiques émis par la plaque absorbante de l’ordre de 5.2K et 6.5K 

respectivement. Dans toute les configuration ces fluctuations sont transmises 

directement au fluide (eau) et elles sont amortie. Ces fluctuations ne figurent 

quasiment pas sur les courbes de configuration du milieu et du bas, À 9h10, la 

fluctuation de l’ordre de 5.2K à subit un amortissement de l’ordre de 5K dans la 
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configuration d’en bas et de 4.8K dans la configuration du milieu et de 4.1K dans la 

configuration d’en haut et la 2émé fluctuation apparue à 13h10 de l’ordre de 6.5K est 

amortie d’une valeur de 6.2K dans la configuration du bas et de 4.8K dans la 

configuration du milieu et 4.2K dans la configuration d’en haut, ce qui reflète le 

comportement thermique du sable où l’amplitude thermique décroit en s’éloignent 

de la source de chaleur. Le positionnement de l’ÉcTh est un paramètre influant dans 

la variation de la température de sortie, car on constate que la température de sortie 

la plus élevée est celle où l’ÉcTh est en haut, puisque l’énergie absorbée par la plaque 

absorbante est directement transmise vers l’ÉcTh ensuite vers le fluide. 

L’écart de température entre l’entrée et la sortie augmente et attient une 

valeur maximale de 40K, 17K et 12K à 14h20 pour les configurations d’en Haut, Milieu 

et Bas respectivement. 

 

Figure 4.13: Variation de l’écart de température pour chaque configuration et pour  
evs=0.025m (29 Janvier) 

La  figure 4. 14 représente l’évolution de la température d’entrée, de sortie 

pour les trois configurations et la température de la plaque absorbante. Le CSTPSSI a 

un comportement thermique identique à l’essai du 23 Juin, avec les mêmes écarts 
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d’amortissements thermiques des fluctuations. On constate que les plus grandes 

températures sont enregistrées en été et que la température de sortie maximale 

atteinte durant cette journée est de 346K, 323K et 318K à 13h50 pour les trois 

configurations ; Haut, Milieu et Bas respectivement. Durant cet essai, une fluctuation 

apparait sur la courbe d’entrée d’eau de l’ordre de 4.6K à 15h10 affecte la 

température de sortie. Comme indiqué dans la figure 4.15, la configuration du haut 

amortit mieux la fluctuation avec une valeur de 2.5K suite au contact direct entre la 

plaque absorbante et l’ÉcTh, puis les deux configurations du milieu et d’en bas sont 

identiquement amorties à 2K, cette légère diminution d’amortissent 0.5K 

comparativement à la configuration d’en haut est dû à l’éloignement de l’ÉcTh de la 

plaque absorbante, l’énergie absorbée par la plaque absorbante est transférée 

d’abord à a la couche de sable puis à l’ÉcTh . Cela signifie qu’une fluctuation émise 

par la plaque absorbante est mieux amortie que celle émise par le fluide caloporteur.  

 

Figure 4.14: Évolution de la température de sortie des trois configurations (bas, milieu et 
haut) pour evs=0.025m (23 Juin) 
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Figure 4.15 : Variation de l’écart de température pour chaque configuration et pour 

evs=0.025m (23 Juin) 

La figure 4.17 représente les contours de température dans les deux plans de 

mesure (transversal et longitudinal) (voir Fig. 4.16) des trois configurations durant les 

deux essais aux instants où la température de la plaque absorbante est à son apogée, 

c. -à-d. à 14h20 le 29 Janvier et 13h50 le 23 Juin.  
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(Milieu et Bas) est plus évidente autour et à proximité des tubes de l’ÉcTh, car la 

différence de température entre l’eau est le sable diminue dans le sens de 

l’écoulement de l’eau. Le cas où l’ÉcTh est en bas c. -à-d. à une distance de 0.011m de 

la plaque absorbante, l’eau récupère l’énergie thermique stockée dans le sable. 

     

(a)                                                        (b) 

Figure 4. 16: Plans de mesure dans le CSTPSSI ; (a) longitudinal (b) transversal 

  

        
29 Janv-14h20-Bas 

       
23 Juin-13h50-Bas 
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29 Janv-14h20-Milieu 

         
23 Juin-13h50-Milieu 

  

 
29 Janv-14h20-Haut 

 
23 Juin-13h50-Haut 

Figure 4.17: Comparaison des profils de température des trois configurations (bas, milieu et 
haut) pour  evs=0.025m durant 29 Janvier et 23 Juin 

4.5.2 Epaisseur du volume de stockage evs =0.02m : 

La figure 4.18 représente la variation de la température de sortie pour 

différents positionnements de l’ÉcTh (bas, milieu et haut) pour une épaisseur du 

volume de stockage evs=0.02m, ainsi que la température des deux paramètres 

influant (température d’entrée d’eau et température de la plaque absorbante) durant 

le jour d’essai du 29 Janvier. 
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Commençons par la configuration d’en haut où l’ÉcTh est en contact direct 

avec la plaque absorbante, la température de sortie varie avec la variation de la 

température de la plaque absorbante et atteint une valeur maximale de 331K à 14h20 

avec un amortissement thermique des fluctuations au milieu de journée de l’ordre de 

4K. La température de sortie des deux autres configurations (bas et milieu) atteignent 

des valeurs maximales 308K et 312K à 14h10 avec un amortissement thermique des 

mêmes fluctuations de l’ordre de 5.6K et 5.3K respectivement (voir Fig. 4.19). 

 

Figure 4.18: Évolution de la température de sortie des trois configurations (bas, milieu et 
haut)  pour evs=0.02m (29 Janvier) 
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Figure 4.19 : Variation de l’écart de température de sortie et de température de la plaque 
absorbante pour chaque configuration pour evs=0.02m (29 Janvier) 

La figure 4.20 montre la variation de la température de sortie des trois 

configurations ainsi la température de sortie et la température de la plaque 

absorbante pour une épaisseur evs=0.02m durant le 23 juin. Les trois configurations 

(bas, milieu et haut) atteignent des valeurs maximales de 322K, 327K et 345K 

respectivement à 13h50. La fluctuation qui apparait dans la courbe de température 

d’entrée d’eau de l’ordre de 4.6K à 15h10 est amortie progressivement du bas vers le 

haut par les valeurs suivantes : 2.15K, 2.26K et 2.42K (voir Fig. 4.21). 
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Figure 4.20: Évolution des températures de sortie pour les trois configurations et les 
températures d’entrée d’eau et de la plaque absorbante pour evs=0.02m (23 juin) 

 

Figure 4.21 : Variation de l’écart de température de sortie et de température de la plaque 
absorbante pour chaque configuration pour evs=0.02m (23 Juin) 
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courbe de la plaque absorbante durant  les deux jours d’essais, car, l’ÉcTh est en 

contact direct avec la plaque absorbante où l’énergie thermique absorbée par la 

plaque absorbante est directement transmise vers l’ÉcTh. L’évolution de la 

température de sortie est très sensible, elle ne cesse d’augmenter dès l’apparition du 

soleil et atteint une valeur maximale 344K à 14h30 et 360K à 13h50 durant le 29 

Janvier et le 23 Juin respectivement. Le signal thermique émis par la plaque 

absorbante durant le 29 Janvier à 14h20 est de l’ordre de 370K, ce dernier est reçu 

par l’eau à 14h30 avec la valeur de 344K, ce décalage de temps dans la réception du 

signal est le déphasage qui signifie qu’il y a eu une charge et  une décharge thermique 

de 10minutes.  

 

Figure 4.22 : Évolution de la température de sortie pour une épaisseur du volume de stockage 
pour evs=0.014m (29 Janvier) 
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Figure 4.23 : Évolution de la température de sortie pour une épaisseur du volume de stockage 
pour evs=0.014m (23 Juin) 
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Figure 4.24 : Variation de l’écart de température de sortie numérique et de température de la 
plaque absorbante pour chaque configuration pour evs=0.014m (29 Janvier) 

 

Figure 4.25 : Variation de l’écart de température de sortie numérique et de température de la 
plaque absorbante pour chaque configuration pour evs=0.014m (23 Juin) 
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deux jours d’essais. Pour se faire, on a remplacé le sable dans la simulation par l’air 

dont les propriétés thermophysiques disponibles dans la bibliothèque du logiciel. 

La figure 4.26 représente la variation de la température de sortie pour une 

épaisseur du volume de stockage evs=0.014m et sans l’intégration du matériau de 

stockage durant la journée du 29 Janvier. La température de sortie augmente et 

diminue avec celle de la plaque absorbante et atteint une valeur maximale de 305K à 

13h50. L’écart de température entrée et sortie est très faible en début et en fin de 

journée de l’ordre de 1K jusqu’à 8h50 puis augmente en milieu de journée et atteint 

une valeur maximale de l’ordre de 14K, ceci est expliqué par la très faible 

conductivité thermique de l’air qui le rend un bon isolant.  

La figure 4.27 montre que les fluctuations thermiques produites par la plaque 

absorbante d’une valeur de 5K et 6.5K à 9h10 et 13h10 qui sont  amorties de l’ordre 

de 4K et 5K respectivement, alors dans ce cas l’amortissement thermique n’a aucun 

intérêt. Le faible écart de température entrée et sortie est expliquée par le fait que 

l’air a une très faible conductivité thermique ce qui empêche le transfert thermique 

autour des tubes de l’ÉcTh sauf au point de contact entre la plaque absorbante et 

l’ÉcTh.  

 

Figure 4.26 : Évolution de la température de sortie sans l’intégration du matériau de 
stockage « SMS» pour evs=0.014m (29 Janvier) 
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Figure 4.27 : Variation de l’écart des températures du CSTPSSI SMS pour evs=0.014m (29 Juin) 
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Figure 4.28: Évolution de la température de sortie sans l’intégration du matériau de stockage 
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Figure 4.29: Variation de l’écart des températures du CSTPSSI SMS pour evs=0.014m (23 Juin) 
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absorbante et l’ÉcTh stocke une quantité de chaleur et là transmise amortie sans là 

retarder.  

Par contre, la figure (4.33) illustre l’amortissement de température de la 

fluctuation imposé par la température d’entrée d’eau de la journée du 23 Juin à 

15h10, cette dernière évolue paradoxalement à celui de la journée du 29 Janvier, c. -

à-d. que l’amortissement de température augmente avec la diminution de l’épaisseur 

du volume de stockage ainsi qu’au rapprochement de l’ÉcTh à la plaque absorbante. 

 

Figure 4.30 : Évolution de l’amortissement de température de sortie (5.2K) en fonction de 
l’espace pour la fluctuation du 29 Janvier à 9h10 
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Figure 4.31 : Évolution de l’amortissement de température de sortie (6.5K) en fonction de 
l’espace pour la fluctuation du 29 Janvier à 13h10 

 

Figure 4.32 : Évolution de l’amortissement de température de sortie (3K) en fonction de 
l’espace pour la fluctuation du 29  Janvier à 15h40 
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Figure 4.33 : Évolution de l’amortissement de température de sortie (4.6K)  en fonction de 
l’espace pour la fluctuation du 23  Juin à 15h10 
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Figure 4.34 : Évolution des températures de sortie du CSTPSSI SMS et AMS pour evs=0.014m  
 (29 Janvier) 

 

Figure 4.35 : Évolution des températures de sortie du CSTPSSI SMS et AMS pour evs=0.014m 
(23 Juin) 

 

 

 

 

 

0
8
:5

0

0
9
:4

0

1
0
:3

0

1
1
:2

0

1
2
:1

0

1
3
:0

0

1
3
:5

0

1
4
:4

0

1
5
:3

0

1
6
:2

0

1
7
:1

0

1
8
:0

0

280

290

300

310

320

330

340

350

360

370

380

T
e

m
p

é
ra

tu
re

 (
K

)

Temps (Heures)

 T
e

 T
Abs

 T
SMS

 T
AMS

0
7
:1

0

0
8
:0

0

0
8
:5

0

0
9
:4

0

1
0
:3

0

1
1
:2

0

1
2
:1

0

1
3
:0

0

1
3
:5

0

1
4
:4

0

1
5
:3

0

1
6
:2

0

1
7
:1

0

1
8
:0

0

1
8
:5

0

1
9
:4

0

300

310

320

330

340

350

360

370

380

390

T
e

m
p

é
ra

tu
re

 (
K

)

Temps (Heures)

 T
SMS

 T
e

 T
Abs

 T
AMS



Analyse des performances de différentes conceptions du CSTPSSI 

 

112 
 

4.9 Conclusion : 

Les résultats de la simulation en 3D ont permis de bien analyser le 

comportement thermique et montrer que la modification en terme de dimensions 

ainsi de matériaux joue un rôle important dans l’efficacité du CSTPSSI, c. -à-d. qu’on a 

obtenu des températures de sortie très satisfaisantes. Ceci montre l’effet de 

redimensionnement du volume de stockage et l’intégration du sable dans le capteur 

solaire thermique plan sur l’augmentation de la température de sortie et sur 

l’amortissement des fluctuations dues aux passages nuageux à très court terme ainsi 

qu’aux fluctuations imposées par l’installation même. On a constaté aussi, que la 

période d'onde thermique dans le sable reste inchangée pour chaque épaisseur du 

volume de stockage avec les différents positionnements de l’ÉcTh, tandis que son 

amplitude décroît exponentiellement avec la diminution de l’épaisseur du volume de 

stockage.  

L’augmentation de l’épaisseur du volume de stockage implique l’augmentation 

de la masse du sable entrainant une augmentation de la quantité de chaleur stockée 

qui est restituée instantanément lors des fluctuations. Une augmentation significative 

de la température de sortie de l’ordre de 54% avec l’intégration du sable dans le 

volume de stockage. La visualisation des contours de température a montré une 

uniformité de température dans le plan de mesure et une  forte dépendance entre le 

transfert thermique dans le sable et dans l’eau qui est traduit par échange thermique 

important entre le sable et l’ÉcTh en s’éloignant de la plaque absorbante.  

Toutes les configurations présentent des avantages tels que l’amortissement 

de température et des inconvénients tels qu’une faible température de sortie. Enfin, 

la configuration retenue est celle avec une épaisseur du volume de stockage égale à 

0.014m dont l’ÉcTh est en contact avec la plaque absorbante d’une part et par le fond 

du volume de stockage d’autre part.  
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L’objectif de cette thèse est la contribution à l’étude de faisabilité et 

d’optimisation d’un système de stockage thermique intégré dans un capteur solaire 

thermique plan destiné à produire l’eau chaude sanitaire et à stocker de l’énergie 

solaire, en utilisant le sable fin (dunes) pour des fins écologiques et économiques. Cette 

étude a été menée par une analyse du comportement thermique de deux systèmes à la 

fois ; le capteur solaire thermique plan à eau et le système de stockage, et cela à travers 

une étude expérimentale et numérique.  

Dans un premier temps, nous avons rassemblé quelques informations générales 

sur la captation thermique incluant une démonstration de la chaine de conversion 

thermique, puis, les différents types de capteur solaires thermiques. Ensuite nous avons  

exploré l’état de l’art technologique des différents capteurs solaire thermique à stockage 

intégré. A l’issue de cette investigation, nous avons constaté que chaque capteur solaire 

à stockage intégré présente des avantages qui favorisent son utilisation et le rendent 

adapté aux conditions environnementales spécifiques de son lieu d’implantation (climat, 

moyens matériels et besoins). 

Après l’étude de l’état de l’art, nous avons procédé à la présentation du dispositif 

expérimental conçu et réalisé localement au niveau de l’atelier de génie mécanique de 

l’université Ammar Telidji de Laghouat (Algérie). La phase suivante consiste à tester le 

prototype sous des conditions réelles, cela par la réalisation des essais journaliers (du 

lever au coucher du soleil) en  période hivernale et estivale. Cette phase est clôturée par 

l’acquisition des températures en différent endroits du prototype ainsi que la 

température ambiante et la vitesse du vent. Pour les simulations numériques, nous 

avons présenté le modèle mathématiques 3D sous l’environnement Ansys CFX adoptés 

pour la simulation du transfert de chaleur dans un capteur solaire à eau avec stockage 

intégré.   



   Conclusion générale et perspectives  

 

115 
 

Puis, après une étude de sensibilité au maillage, au pas de temps et au critère de 

convergence nous avons validé notre modèle numérique. 

Les résultats expérimentaux ont permis de déterminer la température de sortie, 

les profils de la température dans le volume de stockage ainsi que l’estimation de 

l’énergie stockée dans le sable pour une épaisseur du volume de stockage evs=0.15m et 

un positionnement de l’échangeur thermique à une profondeur P=0.05m. Ces résultats 

présentent de très faible écart entre les températures entrée et sortie durant les deux 

jours d’essais (29 janvier et 23 juin), le stockage thermique été bien présent avec un 

décalage de temps (déphasage) important en début et en fin de journée mais avec une 

amplitude très faible. Ceci nous a incités à mener une étude paramétrique pour 

l’épaisseur du volume de stockage, positionnement de l’échangeur ainsi que l’utilisation 

du sable ou non.  Nous avons mis en évidence que la meilleure température de sortie est 

obtenue avec une épaisseur du volume de stockage evs=0.014m de l’ordre 92% (344K) et 

que le meilleur amortissement de température de l’ordre de 95% est obtenu pour la 

configuration avec une épaisseur du volume de stockage evs=0.025m et une profondeur 

de l’changeur P=0.011m (bas). En outre, l’utilisation du sable augmente 

significativement la température de sortie de l’ordre de 40%. 

Le capteur solaire thermique plan à eau avec un système de stockage intégré 

d’une épaisseur de volume de stockage evs=0.014m se montre satisfaisant du point de 

vue énergétique. Économiquement, la diminution de l’épaisseur du volume de stockage 

de 0.15m à 0.014m a conduit à la diminution de la masse du capteur d’environ 90% de 

son poids initial, ainsi que la diminution des parois latérales entrainant une réduction en 

termes de couts des matériaux utilisés pour chemisage et l’isolation. 

 Les perspectives de cette étude sont nombreuses, surtout concernant l’étude 

numérique, contrairement à l’étude expérimentale où on est obligé de respecter la 

disponibilité du matériel de conception et des matériaux constituants. De ce fait, le 
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capteur solaire thermique plan à eau avec un système de stockage intégré mérite une 

étude supplémentaire pour l’amélioration de la géométrie de l’échangeur thermique 

afin d’augmenter la surface d’échange thermique et d’éliminer le circulateur, ce dernier 

va baisser le cout de l’installation. D’ailleurs, une étude sur la durée de stockage par 

l’ajout d’un matériau avec le sable afin de prolonger la durée de stockage (sans affaiblir 

l’amplitude thermique tout on augmentant le déphasage). 
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Généralités sur les transferts thermiques [53] [56] [67] : 

A.1 Flux de chaleur transmis par conduction : 

C’est le transfert de chaleur au sein d’un milieu opaque, sans déplacement 

de matière, sous l’influence d’une différence de température. La propagation 

de la chaleur par conduction à l’intérieur d’un corps s’effectue selon deux 

mécanismes distincts : une transmission par les vibrations des atomes ou 

molécules et une transmission par les électrons libres. 

 

Figure A.1 : Schéma de transfert de chaleur conductif 

𝛷 =  𝜆 𝐴
𝜕𝑇

𝜕𝑋
                                             (A.1)                                                            

A.2  Flux de chaleur transmis par convection : 

C’est le transfert de chaleur entre un solide et un fluide, l’énergie étant 

transmise par déplacement du fluide. Ce mécanisme de transfert est régi par 

la loi de Newton : 

 

Figure A.2 : Schéma du transfert thermique convectif 

 

Φ = hA(Tp − T∞)                                                                                     (A.2) 
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A.3   Flux de chaleur transmis par rayonnement : 

C’est un transfert d’énergie électromagnétique entre deux surfaces 

(même dans le vide). Dans les problèmes de conduction, on prend en compte 

le rayonnement entre un solide et le milieu environnant et dans ce cas nous 

avons la relation : 

 

Figure A.3 : Schéma du transfert de chaleur radiatif 

𝛷 = 𝜎𝜀𝑝𝐴(𝑇𝑝
4 − 𝑇∞

4 )                                                                                (A.3) 

A.4   Bilan thermique global d’un capteur solaire thermique plan : 

Le bilan thermique de la paroi absorbante s’écrit : 

Φab =  Φst +  Φu  + Φp                                                                        (A.4) 

D’où : Φab : Flux solaire absorbé, 

Φp : Flux perdu par la paroi absorbante, 

Φu : Flux utile transmis au fluide caloporteur, 

Φst : Flux stocké dans le capteur qui s’écrit. 

La puissance stockée par le capteur s’écrit : 

Φst =  ∑ micpi
 
∂T

∂t

n
i=1                                                                                 (A.5) 

La puissance absorbée par le capteur s’écrit : 

Φab = τv αpA Ht                                                                                       (A.6) 
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D’où : αp : Coefficient d’absorption de la paroi absorbante par rapport au 

rayonnement solaire, 

τv : Coefficient de transmission de la couverture transparente par 

rapport au rayonnement solaire. 

Dans le cas où le fluide caloporteur ne subit pas de changement d’état, le flux 

utile s’écrit : 

Φu =  ṁcp(Ts − Te)                                                                                  (A.7) 

Les déperditions thermiques du capteur sont mises sous la forme [56]: 

Φp =  A Utotal(Tpm − Ta) = A(Uar + Uav + Ul)(Tpm − Tamb)               

(A.8) 

Avec : 

Uar =
λi

ei
                                                                                                         (A.9) 

Ul =
λl Al

el Acap
                                                                                            (A.10) 

D’où : Uar : le coefficient des pertes arrière ; 

Ul : le coefficient des pertes latérales ; 

Al : surface des parois latérales ; 

Acap : surface du capteur solaire ; 

λl : conductivité thermique de l’isolation latérale ; 

el : épaisseur de l’isolation latérale. 

Une équation empirique pour Uav a été développée par Klein (1979) en 

suivant la procédure de base de Hottel et Woertz (1942) et Klein (1975). Cette 

relation correspond aux températures  moyennes de la plaque absorbante 

varies entre la température ambiante et 200 °C [56][68]. 
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Uav= (
N

C

Tpm
[

(Tpm-Ta)

(N+f)
]
e +

1

hv
)

-1

+
σ(Tpm+Ta)(Tpm

2 +Ta
2)

(εp+0,00591 N hv)
-1

+
2N+f-1+0,133εp

εv
-N

                        (A.11) 

Avec : 

f = (1+0,089hv-0,1166hvεp)(1+0,07866N)                                         (A.12) 

C=520(1-0,000051β2)  pour : 0°<β<70°, 70°<β<90°                           (A.13) 

e=0,430 (1-
100

Tpm
)                                                                                         (A.14) 

Tpm=
3Ts+Te

4
+∆T                                                                                            (A.15) 

D’où :Utotal : Coefficient des pertes total  

Tpm : Température moyenne de la paroi absorbante, 

ΔT : Ecart de température entre le fluide et plaque absorbante. 

A.5  Rendements d’un capteur solaire : 

Les rendements d’un capteur sont définis par rapport au flux solaire 

incident de la manière suivante : 

η =  
Φu

Ht A
                                                                                                   (A.16) 
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B.1  Configuration du modèle sur CFX : 

Pour commencer, il faut tout d'abord sauvegarder le modèle du maillage 

généré sous le format "cmdb" accepté par CFX. Le fichier ainsi sauvegardé est 

importé par CFX.  

Une fois le fichier est importé par CFX-pre, on procédera à la configuration 

du modèle pour le solveur. Les étapes à suivre sont les suivantes: 

1. Dans la menu Outline > Simulation > Flow analysis :  

- On choisit l’option régime transitoire dans <Analysis type> ;  

- On introduit la durée du temps total (du coucher au lever du 

soleil, 36000s pour le 29 Janvier et 48600s pour le 23 Juin) dans 

<Time duration> ; 

- On introduit le pas de temps (Δt=300s) dans <Time steps> ; 

- On introduit le temps initial (t=0s) dans <Initial time>. 

 

2. Créer les domaines appropriés pour chaque matériau à partir du menu 

(barre d’outils) Insert et leur attribuer des noms (nomenclature des 

domaines) comme suit : 

- Insert > Domain1= Eau > Basic settings: localiser le domaine sur la 

géométrie dans <Location> puis sélectionner le type du domaine 

(fluide) dans <Domain type>, choisir la matière; eau dans 

<Material library>, puis introduire la pression ambiante (101325 

Pa) dans <Reference pressure>. 

- Insert > Domain1= Eau > Fluid models: choisir l’option ; énergie 

thermique  dans <Heat transfer> avec écoulement laminaire dans 

<Turbulence> 

- Insert > Domain1= Eau > Initialization: inclure la température 

d’entrée d’eau mesurée à l’instant t=0s par rapport à chaque 



Annexe B 

 

130 
 

journée dans <Temperature> et prendre en compte que la vitesse 

à t=0s est nulle dans <Cartesian velocity components>. 

- Insert > Domain 2 = Tube  > Basic settings: localiser le domaine 

sur la géométrie puis sélectionner le type du domaine (solide) 

dans <Domain type>, choisir la matière ; cuivre dans <Material 

library>. 

- Insert > Domain 2 = Tube  > Solid models: choisir l’option ; 

énergie thermique  dans  <Heat transfer >. 

- Insert > Domain 2 = Tube  > Initialization: inclure la température 

du tube mesurée au point  ̎4  ̎ à t=0s par rapport à chaque journée 

dans <Temperature>. 

- Insert > Domain 3 = Matière  > Basic settings: localiser le domaine 

sur la géométrie  puis sélectionner le type du domaine (solide 

dans le cas du sable) dans <Domain type>, introduire les 

propriétés physiques du sable dans la bibliothèque <Insert > 

Material>. 

- Insert > Domain 3 = Matière  > Solid models: choisir l’option ; 

énergie thermique  dans <Heat transfer>. 

- Insert > Domain 3 = Matière  > Initialization >  inclure la 

température de la plaque absorbante à t=0s par rapport à chaque 

journée dans <Temperature>. 

 

3. L’étape suivante consiste à établir les conditions aux limites 

<Boundary> à partir du menu et cela pour chaque domaine créé : 

- Insert > Boundary 1 > Basic settings: localiser sur la géométrie 

une région (entrée du tube) sur laquelle on applique les 

conditions aux limites, dans <Location>. 

- Insert > Boundary 1> Boundary details: définir le régime 

d’écoulement comme subsonique dans <Flow regime> en suite, 
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introduire le débit massique (ṁ=0.0061 kg/s) dans <Mass and 

momentum> .La température d’entrée d’eau mesurée est 

introduite par une expression (l’expression égale à une fonction 

écrite sous forme tabulaire) dans <Heat transfer>. 

- Insert > Boundary 2 > Basic settings: localiser la sortie du tube sur 

la géométrie dans <Location>. 

- Insert > Boundary 2 > Boundary details: on garde les mêmes 

conditions aux limites appliquées au Boundary 1 sauf que la 

température de sortie d’eau ne figure pas, car cette dernière est 

le résultat final des calculs.  

- Insert > Boundary 3 > Basic settings: localiser les parois latérales 

et la paroi inférieure du capteur sur la géométrie dans <Location>. 

- Insert > Boundary 3 > Boundary details: définir les parois 

localisées comme parois adiabatiques (représente l’isolation). 

- Insert > Boundary 4 > Basic settings: localiser la paroi qui 

représente la plaque absorbante du capteur sur la géométrie. 

- Insert > Boundary 4 > Boundary details: introduire la température 

de la plaque absorbante mesurée durant les deux essais par une 

expression (l’expression égale à une fonction écrite sous forme 

tabulaire) dans <Heat transfer>. 

4. créer les interfaces entre les domaines : 

- Insert > Domain interface 1 > Basic settings: choisir  fluide-solide 

dans <Interface type>, fluide-tube représente l’interface entre 

l’eau et la face intérieure du tube. Générer une connexion entre 

l’eau et la face intérieure du tube dans <General connexion>. 

- Insert > Domain interface 2 > Basic settings: choisir  solide-solide 

dans <Interface type>, tube-matière représente l’interface entre 

la face extérieure du tube et la matière. Générer une connexion 
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entre la face extérieure du tube et la matière dans <General 

connexion>. 

5. Solveur 

Dans le menu Outline > Simulation > Solver > Output control > Trn results: 

introduire le pas de temps du résultat (Δt=300s) dans <Output frequency>.  
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C. 1  Comparaison des profils de température : 

  

        
Bas-14h20-29 janvier 

       
Bas-13h50-23 juin 

 

 

 

 

 
Milieu-14h20-29 janvier 

 
Milieu-13h50-23 juin 
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Figure C.1: Contours de température dans le plan transversal et longitudinal du capteur durant 
29 Janvier et 23 Juin (evs=2cm) 

   

  

  

 
Haut-14h20-29 janvier  Haut-13h50-23 juin 

Figure C.2 : Contours de température dans le plan transversal et longitudinal du capteur  pour 
une épaisseur du volume de stockage evs=1.4cm 

  

 
Haut-14h20-29 janvier 

       
Haut-13h50-23 juin 


	Dans ce contexte, nous avons mené une étude expérimentale qui consiste à  réaliser un capteur solaire thermique plan à eau avec un système de stockage intégré, dont le matériau utilisé pour le stockage thermique est le sable fin, le choix du sable fin...

